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Pro Call 

Where did my Pro Call screen Go? 
Pro Call is designed to start when your computer starts so the service should always be running. If you do not see the Pro Call icon 
on your task bar, follow these simple steps to get it back 
1. Expand the icons in your system tray by selecting the arrow that is next to it. If no arrow is there, proceed to step 2. (Your 

system tray is the list of icons for services running and is located by your computers clock. Typically the lower right corner of 
your screen) 

2. Right Click the CallerID icon (it’s a wrench with a black square around it) 
3. Select the Call Log option from its menu. The Pro Call window opens 

Configure Pro Call Settings 
1. From Pro Call 
2. Select the Settings tab 
3. Select your Shop Management System using the drop down menu 

3.1. Select your ODBC Data Source using the drop down menu. For multi-location databases, a LocationID field will display. Be 
sure to select your location from its dropdown list 

4. Select the Radio button for the type of monitoring it will do 
4.1. Hardware – the default selection used when the CallerID hardware device is used to wire your analog phone lines or your 

VoIP internet lines to your router 
4.2. Software – select this option if your VoIP providers server will send an HTTP notification to our server 

5. Demo Mode (press F5, F6 to simulate a call) - Select this radio button to allow for demonstrations and/or training 
6. Show Call Script On Incoming Call Select – Select this radio button if you would like the user answering the phone to have your 

call script displayed along with the Customer details when Selecting the incoming call notification 
7. Select the Edit Call Script button to enter the script that your staff should use for incoming calls (a new window opens 
8. Configure the length of time in seconds that the incoming call notification should remain available to Select on 
9. Yellow car icon – configure the number of months that a car can be away before turning the icon yellow in the Customers 

Vehicle detail screen of Pro Call 
10. Red car icon – configure the number of months that a car can be away before turning the icon red in the Customers Vehicle 

detail screen of Pro Call 

Open Customer/Vehicle/Order Activity Detail 
When an incoming call is detected by Pro Call, an incoming call notification is displayed that contains the Caller-ID information 
supplied by your phone carrier. There are a few ways to step in to the details for that phone number 

Single Record Match on phone number 
The incoming call notification screen will display with the customer name and contain a green icon in the lower left corner of the 
notification box 
1. Select the notification box 
2. The Customer/Vehicle details screen opens with all the data you need to have an intelligent conversation with the customer on 

the other end. If the Show Call Script option is selected, your configured call script window will also open which works well 
when training new hires or retraining existing staff. 
2.1. Customer name, address and email 
2.2. Customer spending snippet 
2.3. List of Vehicles Owned (Notice the color of the vehicles icon) as this indicates at a glance how recently the vehicle has 

been serviced. Hover over the icon to see the last in date for that vehicle 
2.4. Notice the text color of the Vehicle, if it’s green, Double Click to view the recommendations for that vehicle 

Multiple Record Match on phone number 
The incoming call notification screen will display MULTIPLE RECORDS 
1. Select the notification box. The list of potential matches is displayed 
2. Select the customer record for the customer that you are speaking with 
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3. The Customer/Vehicle details screen opens with all the data you need to have an intelligent conversation with the customer on 

the other end 
3.1. Customer name, address and email 
3.2. Customer spending snippet 
3.3. List of Vehicles Owned (Notice the color of the vehicles icon) as this indicates at a glance how recently the vehicle has 

been serviced. Hover over the icon to see the last serviced date for that vehicle 
3.4. Notice the text color of the Vehicle, if it’s green, Double Click to view the recommendations for that vehicle 

From the main Pro Call screen 
1. Double Click a phone call transaction that has a green person icon 
2. The Customer/Vehicle details screen opens with all the data you need to have an intelligent conversation with the customer on 

the other end 
2.1. Customer name, address and email 
2.2. Customer spending snippet 
2.3. List of Vehicles Owned (Notice the color of the vehicles icon) as this indicates at a glance how recently the vehicle has 

been serviced. Hover over the icon to see the last serviced date for that vehicle 
2.4. Notice the text color of the Vehicle, if it’s green, Double Click to view the recommendations for that vehicle 

Display Vehicle Snippet data 
1. Select a Vehicle to display the vehicle snippet. For customers with a large number of vehicles, use the search box to search the 

vehicle data 

Display Vehicle Recommendations 
1. If the Vehicle text is green, double click it to expose its Recommendations. Sell ‘em if it’s got ‘em! 

Create an Appointment 
1. From the Customer detail screen 
2. Select the vehicle that the appointment is for 
3. Select the Create Appointment icon just above vehicle info. (The New Appointment window opens with customer and vehicle 

info already filled in) 
4. Select the category for the appointment in the category drop down list 
5. Enter the estimated hours for the appointment 
6. Enter notes about the appointment 
7. Select the OK button 

View Customer history 
1. From the customer detail screen 
2. Select the History tab to expose customer history by line item. Quickly search the history by entering search text and hitting 

enter. Records that have matching text will be highlighted 

View your Management Systems Scheduler 
1. From the customer detail screen 
2. Select the Schedule tab to quickly view your management systems scheduler. If the customer already has an appointment on 

the scheduler, the appointment will be highlighted bright pink. 

View the Event Log (also known as Call Log) 
1. From the customer detail screen 
2. Select the Event Log tab to view the available event log for your configuration. If you are looking for specific data, use the 

Search Call Log feature which will highlight what you are looking for in the log. 
2.1. All inbound calls are displayed and if available for your configuration will show these additional events 

2.1.1. Outbound calls 
2.1.2. Invoice Status Change events 
2.1.3. Online Parts Sourcing events 
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Add unmatched phone number to existing customer 
The incoming call notification screen will display with the customer name and contain a gray icon in the lower left corner of the 
notification box 
1. Select the notification box 
2. The Link Customer to phone number screen opens and pre-populates the search box with the caller id name if available 
3. Select the search icon to find the matching customer 
4. Double Click the matching customer to open the Select Phone screen. (This is a list of phone labels and numbers that exist or 

are available in your management system for the selected customer) 
5. Select the phone label that you would like to add the phone number to 
6. Select the Save button 

Lube Sticker Pro 

Print a lube sticker 
1. Select the ProPack Button from a repair order that needs a lube sticker printed. (It is important to note that functionality may 

not exist for Estimates since you should not be printing a lube sticker for un-approved work even if you can set the status of 
the estimate to approved) 

2. Lube Sticker Pro will automatically select the last used interval to apply for this lube sticker. If this oil change has the same 
interval, jump to step 4, otherwise proceed to step 3 

3. Select the radio button that represents the oil change interval to be applied for this oil change (notice that the next odometer 
changes according to your settings and the next date will change based on your settings. If the option Use Vehicle History To 
Calculate Date is selected in your settings, the date will match the predicted date the vehicle will reach the next odometer 
based on its driving habits 

4. Select the Print Button 

Print a Key Tag sticker 
Key Tags can be printed to the Dymo Labelwriter and Brother P-Touch printers. 
1. Select the ProPack button from a repair order that needs a Key Tag sticker printed. (It is important to note that functionality 

may not exist for Estimates since you should not need to print a Key Tag for a vehicle that is not authorized to have work done 
on it) 

2. Select the Key Tag tab 
3. Verify the info populated 
4. Optionally enter a value in the “Other” text box 
5. Select the Print Button 
6. Stick it on the Key Tag 

Run Advanced Scheduling without printing a lube sticker 
1. From the Lube Sticker Pro main screen 
2. Select the Advanced Scheduling icon on the  

HINT: It’s located to the right of the Average Miles Per Day: display and looks like a mini calendar 

Customize oil change intervals 
Oil change settings are configured per workstation, so each workstation will need these settings applied individually 
1. Select the ProPack Button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Verify you are on the LOF tab, if not then Select the LOF tab 
5. Type in the display names for your 3 Oil Types. These are the names that display on the main screen of Lube Sticker Pro and 

should match the nomenclature of what you use around your shop for oil changes that you perform most frequently 
6. Enter the odometer intervals that apply to each of these Oil Types 
7. Enter the time interval in days that apply to each of these Oil Types 
8. If you do not want to use the vehicles history to calculate the date that the vehicle will reach the next odometer, uncheck the 

Use Vehicle History To Calculate Date checkbox (Not Recommended) 
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9. If you want to allow low miles per day vehicles to go longer than your time threshold, uncheck the Do Not Allow Date To Exceed 

Preset Date (Not Recommended) 
10. If you prefer to print the exact next due odometer reading on the lube sticker, uncheck the Round Odometer To Nearest 100. 

(Not Recommended) 
11. Select whether you use Miles or Kilometers in the Units dropdown box. This option controls the value printed in the auto 

recommendation but has no effect on the numerical odometer intervals 
12. Select the Save Button 

Review Lube Sticker Transaction history 
This option is typically used to review the transactions that Lube Sticker Pro performed for a specific Customer and typically comes 
in handy for cases where an automated appointment in the management system is deleted or edited in the management system. 
1. From Lube Sticker Pro 
2. Select the Settings tab 

The settings screen opens 
3. Select the LOF tab 
4. Select the Lube Sticker Transaction History button 
5. In the search drop down, type the last name of the customer and select the drop down arrow 
6. Select the customer from the customer list 

All Lube Sticker Transactions for the customer are displayed. 
6.1. Type identifiers: 

0 – Automatic Recommendation 
1 – Automatic Appointment 

Use YMM oil change intervals 
This feature was removed from the program due to lack of usage. If you would like to see it brought back, send an email to 
support@boltontechnology.com 
1. Select the ProPack Button 
2. Select the Lube Sticker Pro button 
3. Select the Community Recommended Interval button at the bottom of the Lube Sticker Pro window 
4. System will scan the online database for YMM specific intervals. If none are found, you can upload your own by following the 

onscreen prompts to add your own. Be sure to select the Normal or Severe radio button to apply for your existing vehicle and 
fill in time and miles for both Normal and Severe. Your selection will be used when you are returned to the Lube Sticker main 
screen 

5. Select the print button 

Automatically add the next oil change recommendation 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Select the Automation tab 
5. Check the box labeled Auto Add Recommendation 

5.1. Optionally check the Delete Old Recommendations. **NOTE** This only applies to Recommendations that match the text 
in your Recommendation: box 

6. Verify the text in the Recommendation: box is what you would like printed for the description of the vehicle recommendation 
7. Select the Category that will be applied to the recommendation 
8. Select the Save Button 

Automatically add the next oil change appointment 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Select the Automation tab 
5. Check the box labeled Auto Add Appointment 
6. Verify/Edit the Labor Hours that will be filled in on Scheduler for the appointment 
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7. Check the days of the week that Lube Sticker Pro can auto add the appointments 
8. Verify/Edit the default time the auto appointments will be set for 
9. Optionally select one of the following 

9.1. Include Vehicle Unit # in Appointment Notes 
This feature will include the Unit # in the Year Make Model data when added to the appointment notes which comes in 
handy when working with fleet vehicles since many management systems do not link a vehicle to an appointment. 

9.2. Include Vehicle Unit # in Appointment Notes 
This feature will include the License Plate in the Year Make Model data when added to the appointment notes which 
comes in handy when working with customers that may have multiples of the same vehicle since many management 
systems do not link a vehicle to an appointment. 

9.3. As a best practice, a phone call the day before should be placed to the customer to both confirm the appointment and/or 
confirm their vehicle drop-off time. 

10. Select the Save button 

Change the auto recommendation’s description 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Select the Automation tab 
5. Edit the text in the box labeled Recommendation to match your preference 

5.1. If auto recommendations already exist with the previous text, the Delete Old Recommendations will not apply 
6. Select the Save button 

Change the auto recommendation’s category 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Select the Automation tab 
5. Select the drop down arrow in the box labeled Category 
6. Select your preferred category from the drop down list 
7. Select the Save button 

Set the days of the week auto appointments are created on 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Select the Automation tab 
5. In the Shop Open On section, check/uncheck the days of the week that Lube Sticker Pro can create appointments on 
6. Optionally set the default time of day that appointments will be set for 

6.1. Best practice is to call the customer the day before to confirm the appointment and/or confirm the vehicle drop off time 
7. Select the Save button 

Add holidays to schedule exceptions 
This feature allows for the shop to add holidays to the schedule exceptions. When a date is added to this list, Lube Sticker Pro will 
never create an appointment on that date. This works well for holidays that the shop honors as well as other days of the year that 
the shop may close for things like In-House training and Planned Vacation. 
1. From Lube Sticker Pro 
2. Select the Settings tab 

The settings window opens 
3. Select the Schedule tab 
4. Select the date you wish to add on the Calendar date picker on the left 
5. Optionally check the box for Recurring Date Every Year. 

This will add the same date for the next 10 years 
6. Verify your selection 
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7. Select the Add button 

Jump Start my calendar 
This is recommended for new customers only to prefill the next few months with appointments in your Calendar. This will also 
cause Message Manager to begin sending text message appointment reminders. 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Select the Automation tab 
5. Select the Jump Start button 
6. Select an Oil Change Canned job from the first drop down. This helps narrow down the line items for the next selection 
7. Select the Line item that occurs on your oil changes. Once selected, the system will analyze history records to determine 

vehicles that have had an oil change performed in the past, have not returned for service and have a predicted appointment 
into the future. 

8. Select the interval to apply to the analysis. By default, 3 months is selected. Increasing the interval will increase the number of 
appointments that can be booked. It is not recommended to go higher than 6 months. 

9. Verify the number of appointments that will be placed on your calendar 
10. Select the Book Appointments button 

10.1. This action cannot be undone 
11. Select the Save button 

Select my lube sticker printer 

Primary Computer 
We recommend performing this on the computer that the printer is connected to and utilizing the Cloud setting on additional 
computers. See Network Computer 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Select the Management tab 
5. Select the appropriate option for printer type 

5.1. Dymo for a Dymo printer 
5.2. Brother for a Brother printer 
5.3. Zebra Printer for all static cling printers 

6. Select the drop down arrow in the box labeled Lube Sticker Printer 
6.1. Select your label printer from the drop down menu 

Your printer must be shared to be available in the drop down list 
7. Select your Lube Sticker Template if you built one, or had one built with a label designer. 
8. Select the Save button 

Network Computer 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
3. Select the Settings tab 
4. Select the Management tab 
5. Select the Cloud option for printer type 
6. Select the name of the computer that is configured as the Primary Computer from the drop down list. 

**NOTE that if the name of the Primary Computer is not available in the drop down due to MS Windows Network 
Permissions, type the Computer Name of the Primary Computer exactly as it is provided in the Computer Properties screen 
of the Primary Computer.** 

Change the shop info printed on the default lube sticker template 
1. Select the Pro Pack button 
2. Select the Lube Sticker Pro button 
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3. Select the Settings tab 
4. Select the Management tab 
5. Select the Setup Printing button (Go to step 6 for Dymo printers, step 7 for static cling printers) 
6. For Dymo & Brother Printers 

6.1. Enter your Shop Name in the box labeled Line 1 
6.2. Enter your Shop Phone in the box labeled Line 2 
6.3. Optionally Select the Use Image 

6.3.1. Select the lookup button 
6.3.2. In the Windows Explorer window that opens navigate to the folder that contains your shop logo 
6.3.3. Select your shop logo 

6.3.3.1. Recommended Size - .75in x .75in only recommended for thermal printing. Static Cling labels should use a 
pre-printed label with the logo on it. 

6.3.4. Select the Open button 
6.4. Select the Save Button 
6.5. Select the Save Button 

7. For static cling printers (Select the Zebra radio button) 
7.1. Enter your shop name in the box labeled Line 1 

7.1.1. Longer shop names should split their name between Line 1 and Line 2 
7.2. Enter your shop phone in the box labeled Line 3 
7.3. Optionally rotate your label 180 degrees if it prints upside down 
7.4. Select the Save button 
7.5. Select the Save button 

Configure Advanced Scheduling 
This feature is available if you are running Mitchell Manager 6.x.x, also known as SE. Canned jobs can be linked to have an 
automatic recommendation and appointment created. An automatic recommendation and/or appointment will be generated for 
each canned job when the Print button is Selected and the following conditions are met 

 The item is a Repair Order or Invoice (Not an Estimate, since an Estimate does not represent approved work) 

 The canned job has a linked auto recommendation and/or appointment created 

 The canned job exists on the Repair Order/Invoice when a Lube Sticker is printed 
1. From Lube Sticker Pro 
2. Select the Settings tab (The Settings window opens) 
3. Select the Automation tab 
4. Select the Advanced Scheduling button (The Advanced Scheduling button opens) 
5. Select the Add button to add a new configuration or highlight an existing and Select edit to edit the recommendation text 

5.1. Select your canned job title from the drop down list that you want to link an auto recommendation/appointment to. (The 
canned job list is the list of canned jobs that you created in your management system) 

5.2. Uncheck the Auto Add Recommendation checkbox if you do not want the auto creation of the next due recommendation 
for that canned job 

5.3. Uncheck the Delete Old Recommendations checkbox if you want to manually delete performed recommendations in your 
management system when they are performed. (This does not delete all passed due recommendations, only the past due 
recommendations that match that recommendations text) 

5.4. Uncheck the Auto Add Appointment if you do not want to automatically add the vehicles next appointment to your 
management system scheduler. There is built in intelligence that analyzes existing appointments for the vehicle and 
matches the date to prevent more than 1 appointment every 60 days. 

5.5. Add your recommendation text that will show on the vehicle recommendations in your management system 
5.6. Enter the number of miles that can elapse between services. If it’s time only, enter a zero 
5.7. Enter the number of days that can elapse between services 
5.8. Enter the estimated labor time for the service. This is the value that serves as a placeholder estimate in your management 

system scheduler. 
6. Select the Save button 
7. Repeat 5.1 – 6 for each canned job 
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Create my own lube sticker template 
The date and miles are the two main pieces of information that change for each lube sticker printed. To ensure that Lube Sticker 
Pro can successfully supply these variables to the template, the following two variable text elements are required on the template 
1. @LINE1@ - this variable text object will be dynamically replaced with the value entered in Line 1 of the Customize Label 

option which is available in all label templates. It is recommended to limit the number of characters per line to 12 especially 
with the standard static cling label. 

2. @LINE2@ - this variable text object will be dynamically replaced with the value entered in Line 2 of the Customize Label 
option which is available in all label templates. It is recommended to limit the number of characters per line to 12 especially 
with the standard static cling label. 

3. @LINE3@ - this variable text object will be dynamically replaced with the value entered in Line 3 of the Customize Label 
option which is available in all label templates. It is recommended to limit the number of characters per line to 12 especially 
with the standard static cling label. This variable is not available by default on the Dymo and Brother labels. 

4. @MILES@ - this variable text object will be dynamically replaced with the next odometer reading 
5. @DATE@ - this variable text object will be dynamically replaced with the next due date 
6. @TYPE@ - this variable text object will be dynamically replaced with your corresponding Oil Type label from Lube Sticker Pro. 

Defaults are Good, Better, Best but you may customize them to your preference 
7. @TIME@ - this variable text object will be dynamically replaced with the corresponding time for the matching appointment. 

This works well if you transition the sticker from being an Oil Change reminder to a Next Appointment sticker 
8. @WEIGHT@ - this variable text object will be dynamically replaced with your corresponding entry in to the Viscosity field on 

the main form of Lube Sticker Pro. 

Dymo 
Use the Dymo Labelwriter software that came with your Dymo printer 

Brother 
Use the Brother P-Touch software that came with your Brother printer 

Zebra 
Use the ZDesigner software, may require you to purchase from Zebra Technologies 

TT040-50 
Use the Bartender Label Design software that came with your TecLabel printer 

Godex 
Use the GoLabel software that came with your Godex printer 

Report Pro 
Once you have opened Report Pro for the day, keep it open as it is not necessary to re-launch Report Pro every time you want to 
print an Invoice or Report. Report Pro knows which record you have open in your management system and will load the Invoice or 
Report based on that open record. If no Est/RO/Invoice is open, Report Pro remembers the last Est/RO/Invoice that was accessed 
and will load/print the information for that last accessed Est/RO/Invoice. 

Quickly print an invoice 
Report Pro will load and print the Est/RO/Invoice that is currently visible in your Shop Management System or the last accessed 
Est/RO/Invoice if on the Work In Progress Screen.  
1. From Report Pro 
2. Verify that you are on the Home Tab 
3. Select the Quick Invoice button 
4. Go to your printer 

Quickly print a posted invoice 
After posting an Invoice and stepping through your configured Management System options, you are returned to the Work In 
Progress screen on which the posted invoice you want to print is not there. Remember that Report Pro will load and/or print the 
Est/RO/Invoice currently visible in your Shop Management System or the last accessed Est/RO/Invoice. 
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1. From Report Pro 
2. Verify that you are on the Home Tab 
3. Select the Quick Invoice button 
4. Go to your printer 

Quickly Print a Tech Worksheet 
Report Pro will load and or print Tech Worksheet for the vehicle on the Est/RO/Invoice currently visible in your Shop Management 
System or the vehicle on the last accessed Est/RO/Invoice 
1. From Report Pro 
2. Verify that you are on the Home Tab 
3. Select the Quick Vehicle button 
4. Go to your printer 

Manually Print to a Printer 
1. With your selected report loaded in Report Pro 
2. Select the print button (A windows print window opens) 
3. Select an installed printer 
4. Select your number of copies 
5. Select Print 

Export a report 
1. With your selected report loaded in Report Pro 
2. Select the Export button (windows explorer opens) 
3. Select the location to export the file to 
4. Select the format to save the export in (.xls, .csv, .pdf…are among the common) 
5. Select the save button 

5.1. Be sure to remember where you saved your export to. 

Email an Estimate/RO/Invoice 
Remember that Report Pro will load the Est/RO/Invoice currently visible in your shop management system or the Est/RO/Invoice 
last accessed in your shop management system. This feature requires that Configure my email settings has been properly setup. 
1. From Report Pro 
2. Verify you are on the Home tab 
3. Load the Estimate/RO/Invoice to Report Pro by selecting the invoice template, selecting the Reload button or hitting F5 on your 

keyboard 
4. Select the Email button 
5. If the customer has an email in your shop management system it is preloaded in the To field, otherwise enter the email address 

in the To field. You will be prompted to save this email back to the customer record after sending. 
6. Select the Send button 
7. If prompted to Save the Email address for this customer Select Save or Do Not Save 

Preview additional Invoice/Report pages 

Prev Button 
Use this button to view the previous page of the report on screen 

Next Button 
Use this button to view the next page of the report on screen 

Zoom In Button 
Use this button to view the report on screen in normal size 

Zoom Out Button 
Use this button to view the report on screen as a whole page 
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Reload an Invoice/Report 
Selecting the Reload button or the F5 key on your keyboard will reload current data for the selected report. Data loaded is based 
on the open record in your management system. If no record is open, data from the last transacted record will be loaded. 

Customize Invoice 

Header 

Use Logo Invoice 
For best results, image should be created from graphics software. If created using Raster graphics (pixels) the logo should be 
generated for the specific size from the software. If created using Vector software (paths) the image can be resized with little 
effect on the quality. 
Image size should be 2 inches wide by 1 inch high 
Setting is per computer. Place the image in a shared network drive mapped as same folder path on every machine or place the 
logo in the same folder path on each machine. 
1. From Report Pro Select the Customize tab 
2. Select the Customize Invoice button      
3. Check the box Use Logo On Invoice 
4. Select the lookup button (It’s the button with the 3 dots on it) 
5. Open the shared network folder that contains your shop logo (HINT: Instead of navigating via Computer C:\, navigate via 

Network Places>Computer Name>Shared Folder 
6. Select your logo in the folder 
7. Select the open button 
8. Select the Save button 

Show/Hide Shop Info and Vehicle fields 
Checking/Unchecking the box next to each of the following will Show/Hide their corresponding data respectively. 
Shop Name 
Shop Address 
Shop Phone 
Shop Slogan 
License 1 
License 2 
Ref # 
Hat # 
Unit # 
Engine 

Change what date displays when printed 
Select the radio button of the date that you would like to display on your invoices 

Printed Date 
This is the current date 

Posted Date 
The date that the invoice posted to history 

Promised Date 
The date that was promised to the customer for vehicle completion. Can also be used to manually manipulate for printing when 
sending to an accounts receivable customer if your payment terms need tweaking for an expected due date 

Include the Spouse name on invoice 
By default, Company and Customer names will print on the invoice. Check this box if you would like the Customer Name to include 
the Spouse Name field when the corresponding field in your management system is populated. 
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Display Time with Date Display (except simple invoice) 
By default, only the date is printed on the invoice. Check this box if you would like to include the Time when the corresponding 
field in your management system is populated. If this option is selected, and the time is not populated in your management 
system, then the current time will show. 

Display Vehicle Time-In and Time-Out 
By default, this section does not show. Check this box if you would like to show the section that displays the Vehicle Time-In and 
Vehicle Time-Out for the invoice being printed. This section will hide automatically if neither the Time-In nor Time-Out fields 
contain data 

Add a Paid Stamp on zero balance 
An idea borrowed from the QuickBooks Paid invoice. Check this box to add a red PAID stamp to invoices with a zero dollar 
balance. 

Hide All Header Labels 
Several shops reported that they have pre-printed invoice paper that contains the labels for the data so we added the option to 
hide the labels. Check this box if you use pre-printed invoice paper. 

Body 

Invoice Primary Accent Color 
Select the button to select the Primary Accent color to be used on your invoice then select from the pre-defined colors or Select 
the Define Custom Colors >> button and use it to define your color specifically. Typically this is the primary color in your logo. 
There are ten different templates and each use this color differently. Pick the invoice template that you prefer. (HINT: Use the 
color saturation scale in the Define Custom Colors to lighten your color preference as darker saturation can make invoice text 
harder to read, plus you’ll save on toner) 

Invoice Secondary Accent Color 
Select the button to select the Secondary Accent color to be used on your invoice then select from the pre-defined colors or Select 
the Define Custom Colors >> button and use it to define your color specifically. Typically this is the secondary color in your logo. 
There are ten different templates and each use this color differently. Pick the invoice template that you prefer. (HINT: Use the 
color saturation scale in the Define Custom Colors to lighten your color preference as darker saturation can make invoice text 
harder to read, plus you’ll save on toner) 

Show Part Prices 
By default the prices for parts are shown for your invoice part items. Uncheck this box to hide the individual part prices. Keep in 
mind that the part subtotal for a by the job invoice will still show unless it is also unchecked. 

Show Part Numbers 
By default the part numbers are shown for your invoice part items. Uncheck this box to hide the individual part numbers. 

Show Labor Hours 
By default the labor hours associated with a labor line will display in the job subtotal section of the by the job invoice templates. 
Uncheck this box to hid the labor hours for each labor line item 

Show Job Totals 
By default the by the job invoice templates will print the job totals. Uncheck this box to hide the job totals. Keep in mind that the 
Labor Dollars, Labor Hours, Part Dollars and Sublet Dollars will still show unless their corresponding option is unchecked. 

Show labor/Parts Job Total 
Uncheck this option to hide the Labor and Parts totals when using a By the Job invoice template 

Show Sublet Job Total 
Uncheck this option to hide the Sublet labor totals when using a By the Job invoice template 
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Show List Prices (By the Job Invoice Templates Only) 
By default the by the job invoice templates will not show List Prices. Check this box if you sell your parts below list to your 
customers. 

Show Watermark Across Page Background 

Shop Initials 
By default this option is unchecked. Check this box and enter up to two letters in the corresponding text box and those two letters 
will display as a gray scale watermark on your invoice 

Image Path 
Instead of gray scale text, Select the lookup button (button with three dots on it) and map to a logo in a shared network folder. 
Setting is per computer. Place the image in a shared network drive mapped as same folder path on every machine or place the 
logo in the same folder path on each machine. (HINT: Make sure the logo is sized to fit on your paper and is on the lighter end of 
the color spectrum, preferably gray scale as bold colors or logos that are oversized will dominate the invoice instead of enhancing 
it) 

Force Jobs To Group Together 
By default this option is checked. This helps the by the job invoices keep the entire job on the same page if it can, if it cannot then 
the by the job layout will wrap the job to the next page. Uncheck this box if you want all jobs to wrap even if they can fit on a 
single page. 

Only Show First Line of Descriptions 
By default this option is unchecked so that all information typed in to the management system is displayed on the invoice. Check 
this box to so that only the first line of the description is displayed on the invoice. 

Remove New Lines From Descriptions 
By default this option is unchecked so that even the extra blank lines entered in the management system are displayed on the 
invoice. Check this box to so that extra lines are not displayed on the invoice. 

Footer 

Website 
Enter the URL for your website or optionally enter the URL to your review page. If entering your review page, be sure to utilize the 
bit.ly button to shorten the URL, uncheck Show Website Link and check Generate QR code for Website Link. 

Show Website Link 
By default this option is unchecked. Check this box if you have entered your website URL in Website 

Set text color for website link 
Select from the predefined colors or define your own 

Generate QR code for Website Link 
Check this option if you have entered a URL for your website and would like a QR code printed on the last page of your invoice 

Show Tax details when Multiple Taxes 
Check this option if your State/Province requires that you display the individual breakdown of taxes 

Show Disclaimer 
Uncheck this option if your disclaimer is pre-printed on your invoice paper 

Show “I consent to receiving text messages…” boilerplate in disclaimer text 
Uncheck this option to suppress the text message consent notification in the disclaimer text. 
**NOTE: This is not recommended for Message Manager Pro customers as the FCC has recommended that customers be 
notified that they will be receiving transactional text messages** 
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Use Custom HazMat Label 
Check this option if your State/Province requires you to use a custom label for Hazardous Material charges. The label value is 
pulled from your shop management system 

Use Custom Shop Supplies Label 
Check this option if your State/Province requires you to use a custom label for Shop Supply charges. The label value is pulled from 
your shop management system 

Hide Labor, Part, Sublet Totals in Invoice Total box 
Check this option if you wish to hide the totaling of Labor, Parts and Sublet on the last page of your invoice. If using this option, be 
sure that you are not breaking any consumer protection laws and you may want to hide them in the job sub-totaling as well. See 
Show labor/Parts Job Total and Show Sublet Job Total 

Show Technician Names 
Check this option to display a list of technicians that have worked on this invoice 

Show Technician License with Tech Name 
Check this option if your State/Province requires you to display the technicians license number with their name. Be sure to not 
check this option if you store private information in the technicians ID field of your management system 

Sections 

Recommendations 
Check this option to include a recommendations section on the invoice. Note that Portrait templates show or hide the section and 
Landscape templates show or hide the data 

Include Past Due Recommendations 
Check this option to include recommendations where the Need By date is prior to today’s date 

Generate QR Code Appointment 
Check this option to have a QR code generated for the next due recommendation. 

Section Title 
Give this section a custom title to print on the Invoice 

Accent Color 
Set your own custom highlight color to bring attention to this section on the invoice 

Unsold Revisions 
Check this option to display a summary of unsold revisions on the invoice. 
The first line of the revision must be labor or part. 
Only the description of the first labor or part will be printed in the summary 

Show Prices 
Uncheck this option if your sub estimates contain many jobs where the total sub estimate price could mislead the customer since 
only the first labor line is shown as a summary description. 

Section Title 
Give this section a unique title that describes the sub-estimates. Default description is the traditional “Declined Work” 

Sold Revisions 
Classically these represent sub-estimates that were sold to a repair order after initial approval was given. The approval is for the 
additional work and cost to the customer. 

Show All Details for Sold Revisions 
Check this if all the details regarding the customer approval transaction need to be, or you would like to, print on the invoice 
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Section Title 
Give this section a unique title that describes the invoice revisions. Default description is the traditional “Customer Approval” 

Discount 
This section is a special section that will not show if discounts are zero. If Discounts are greater than zero, that amount will print 
big and bold to the right of your section title 

Section Title 
Give this section a unique, catchy title. Default description is the traditional “Discounts”. You could try making something like: 
“TODAY YOU SAVED:” 

Show State-specific Sections 
When this option is selected, Report Pro will add the state specific sections to your Estimate and/or Invoice templates if the State 
in your Shop Information table of your shop management system has one of the following states: WI; FL; MI 

Social Media 
Check the corresponding and link your social media pages to the icon by typing in the URL to your social media page. If you do not 
have one of or any of the following pages, do not check them off as it will mislead your customer in to trying to find you on those 
social media sites. 

Facebook 

Twitter 

LinkedIn 

YouTube 

Sure Critic 

Credit Cards 
It is always a good idea to communicate to your customers what methods of payment that you accept. The big four have icons 
ready to add to your invoice and there are two additional spots to add specialty cards that you accept. Be sure to load the icons 
for those specialty cards in the image path box provided 

Visa 

MasterCard 

Discover 

American Express 

Custom 1 

Custom 2 

Affiliate Logos 
Align your invoice with more branding and familiar names by adding the logos of local brands that you believe in. 
Recommended size – 1in x .5in. Keep in mind that horizontal white space padding should be used on square affiliate logos to 
prevent the logo from being flattened during the rendering process 
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Logo 1 

Logo 2 

Logo 3 

Logo 4 

Logo 5 

Coupons 

Static Coupons 
There are 3 static coupons that print on the invoice when the Show Coupons box is checked (On the last page of portrait invoice 
templates and on even number pages of Landscape invoice templates). Each coupon has 3 editable areas (Line 1 is the large bold 
print coupon offer, Lines 2 through 4 are the three lines for a description and then the coupon footer, which is the same for all 
coupons. Typically the footer is your default coupon disclaimer). 
It is important to note that although the section is called coupons and they print like coupons on the invoice, you can also use 
them for advertising other services you offer at your regular retail price. 
1. From Report Pro Select the Customize tab 
2. Select the Customize Invoice button 
3. Select the Coupons button in the left navigation panel 
4. Select in the Coupon Offer section and enter your single line coupon offer 
5. Select in the Coupon Description section and enter your coupon description (up to 3 lines) 
6. Select in the Coupon Footer section and enter your coupon description (Remember it’s the same for all coupons) 
7. Repeat steps 4 and 5 for each coupon 

Intelligent Coupons 
Report Pro has the ability to make your coupons specific to recommended services that exist for the vehicle on the invoice being 
printed. This is achieved via the Recommendation Category 
1. From Report Pro Select the Customize tab 
2. Select the Customize Invoice button 
3. Select the Coupons button in the left navigation panel 
4. Select the Advanced button in the Coupons section 
5. Select a category in the list of categories in the left box to link a coupon to (Categories that already have a coupon linked are 

highlighted) 
6. Select in the Coupon Offer section and enter your single line coupon offer 
7. Select in the Coupon Description section and enter your coupon description (up to 3 lines) 
8. Repeat steps 5 through 7 for each category you want linked to a coupon. 
Now when a Recommendation with a matching category exists on the vehicle that the invoice is being printed for, that categories 
corresponding coupon is printed instead of the static coupon. Up to 3 Intelligent coupons can be printed when multiple 
recommendations exist, if less than 3 exist then the static coupons are printed. 

Apply invoice customizations on other workstations 
Optional customizations are stored in the database and immediately available on other workstations. Custom logos, such as your 
invoice logo, will need the network paths to each of the logos set manually on each workstation. 
1. From Report Pro 
2. Select the Customize tab 
3. Select the Customize Invoice button 
4. Map the path to each of your custom logos used with the lookup button next to each of the logo path fields. 
5. Click the Save button 

Customize Tech Worksheet 
1. From Report Pro Select the Customize tab 
2. Select the Customize Tech Worksheet button 
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3. Set you preferred Text Color and Background Color for each of the Repair Order line item types (Labor Preview, Parts Preview, 

Sublet Preview, and Notes Preview and Vehicle Memo Preview). If you print it from a color printer, those on screen colors are 
also printed. 

Customer Info 

Use abbreviated customer data section after 1st page 
Checking this box will reduce the number of lines printer for the customer and vehicle info printed on page numbers greater than 
1 while still leaving basic customer and vehicle info so those pages can still be associated with the correct vehicle. 

Use reduced report header section 
Checking this box will reduce the amount of Customer information that displays in the header and collapses the Vehicle 
information displayed to use the full width of the page. 

Technicians 

Display Technicians for Line Items. 
Checking this box will print the names of all technicians for each line item 

Display Tech Pay hours instead of Scheduled Hours. 
Checking this box will print the sum of technician Pay Hours as Hours  instead of Charged Hours for that labor line 

Display Technician Hours on Tech Lines. 
Checking this box will print the Pay Hours for each technician on the labor line in addition to the sum of technician Pay Hours for 
that labor line. 

Display Technicians below vehicle history lines 
Checking this box will display the name of the technician associated with the history line item of the vehicle history report that is 
included at the end of the tech worksheet 

Customize Vehicle History 
This feature allows for the user to control the number of years of history that are included in the vehicle history report. This is also 
the amount of history that displays at the end of the Tech Worksheet. 
1. From Report Pro Select the Customize Tab 
2. Select the Customize Vehicle History button 

Maximum Amount Of History 
3. Enter the number of years back to print on the history report. Keep in mind that 3 years is usually enough to be informative for 

your tech. Increasing the number will make the Vehicle History and Tech Worksheet reports more pages which equals more 
paper when printing. If you enter zero for the years then the Vehicle History report will not show any data nor will it be 
appended to the Tech Worksheet 

Group History By 

Date 
selecting this will display history chronologically descending  

Category 
Selecting this will display history grouped by line item category and expose these additional options 

Only Show Most Recent Result In Each Category 
Selecting this option will only show the most recent date and miles for each category performed for that vehicle. This is a great 
option if your categories are structured well. 

Show ‘Service Not Performed’ Where Applicable 
Selecting this option will display Service Not Performed under every category that has never been performed for that vehicle. May 
not be a good choice if your categories are abundant. 



How Do I 
 
Only Show Labor Lines 
Selecting this option will not show parts info 

Customize Multi Point Inspection without Mobile Manager Pro subscription 

What you should do before customizing 
1. Make a list of categories that represent the service lines that you wish to dynamically track against your shop management 

invoice line items. 
2. Typically these are recurring maintenance services such as Oil Change, Transmission Service, Coolant Service, Front Brake 

Service, Rear Brake Service, Tire Rotation, and Air Filter etc... 
3. As a general guideline, there should be AT LEAST one category for each separate service you wish to track dynamically. You can 

have more but not less. 
4. Compare your list of categories with the list of categories that you already have in your shop management system 
5. Missing Categories should be created in your shop management system 
6. Any category that applies to more than one service should be edited to represent only a single service. [Hint] Make note of 

those categories for help when using Category Tools 

Definitions 
1. Shop Management Category - The category in your shop management system that applies to Parts, Labor, Sublet line items 

on your invoices 
2. Group - Allows for grouping line items on the M.P. Inspection report into sections. Groups and their associated line items are 

alpha sorted so if you have an order preference, place numbers at the beginning of the group and/or line descriptions 
3. Description - The description of the inspection line item as it will display and print on the report. Keep them short and 

descriptive to allow for more lines on a single page 
4. Months Due Back - Maximum number of months that should elapse before the inspection/service needs to be performed 
5. Miles Due Back - Maximum number of miles that should elapse before the inspection/service needs to be performed 
6. Report Title - This is for what you want to name your multi point inspection and is the first line after the header 
7. Disclaimer - If you feel the need to include a disclaimer indicating that the line items represent an inspection guideline only 

and not necessarily actual work performed, it will print in the notes box located at the bottom right side of the report 
8. Adjust Your Interval Ranges - This is a slider bar that allows you to adjust the thresholds at which the font colors change 

based on the service category performed. This is driven by amount of time or miles left on the service 
9. Service Never Performed - This color represents service categories that have never been performed 
10. Service Past Due - This color represents service categories that have been performed and the minimum threshold for time or 

mileage left on the service exists 
11. Service Due Soon - This color represents service categories that have been performed and fall between the minimum and 

maximum thresholds for time and mileage 
12. Service Recently Performed - This color represents service categories that have been performed and the maximum threshold 

for time and mileage still exist 
13. Service No Category - This color represents inspection lines that are not linked to a category, typically used for the courtesy 

checks 
14. Report Theme Color - This is the color used to highlight the group labels and the menu 

Hints 
1. If a service is only tracked on a months due back basis, enter 0 for the Miles Due Back 
2. If an inspection happens every time a vehicle is in and does not have a corresponding line item on an invoice, select <No 

Category> from the Shop Management Category drop-down 
3. Selecting the Reset button to reset the M.P. Inspection defaults cannot be undone 
4. Set your Report Theme Color to match the main color of your logo to help with Brand Recognition 

Customize M.P. Inspection line items and layout 
1. From Report Pro Select the Customize tab 
2. Select the Customize M.P. Inspection button 
3. Multi Point Inspection includes 5 groups and 28 inspection line items as a quick start. These default lines can be edited or 

deleted to match your needs. If you do not see these defaults or wish to reset them, select the Reset button 
4. Select a line you wish to edit. The selected line will be highlighted 
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5. Select the Edit button 
6. Select the Shop Management Category that you would like to link the selected line item to. Line items set to that category in 

your shop management system will track against that inspection line description 
7. Select the Group that represents the section of the report that the Description line will display in. To create a new Group, just 

type the name of the Group label in the box 
8. Verify or edit the description as you would like it to appear on your report 
9. Enter the Months Due Back 
10. Enter the Miles Due Back 
11. Select the Save button 
12. Repeat steps 4 - 11 for each line item to edit 
13. When finished Close the window by selecting the X in the upper right corner 

Customize M.P. Inspection Layout & Intervals 
1. Select the Customize tab 
2. Select the Customize M.P. Inspection button 
3. Select the Layout & Intervals tab 
4. Give your report a title 
5. Add a disclaimer if you prefer 
6. Select and Drag the left slider to set your minimum threshold for time or mileage left on the service 
7. Select and Drag the right slider to set you maximum threshold for time and mileage left on the service 
8. Using the Select Color button for each interval threshold, set the color you prefer for the text to print when a service is 

performed 

Re-categorize my history invoice line items 
It is important to note descriptions as they appear in your management system of the line items (labor, parts, and sublet) that 
you are assigning/re-assigning for entering in the text Category Search can use to search for assigning categories. 

1. Select the tools tab 
2. Select the Category Tools Tab (Category Tools window opens) 
3. Select the Unassign Categories tab 
4. Highlight the category(s) that need line items unassigned 
5. Select the Unassign All Line Items From This Category button 
6. Select the Assign Categories tab 
7. Type your search text in the Search Line Items text box 
8. Alternate method is to Load All unassigned categories 
9. Select the Search button 
10. Highlight the lines that you would like to assign the same category to. Use the Shift+LeftMouseSelect to highlight multiple 

sequential lines or CTRL+LeftMouseSelect to highlight multiple non-sequential lines 
11. Right Select with the cursor in the results grid to bring up your management system category list 
12. Hover over the category you would like to assign the categories to. Use the scroll arrows at the top or bottom of the category 

display window to move the list up or down. 
13. Left Select the category you would like to assign the selected line item(s) to 

Fix history invoice odometer reading 
If you notice a yellow shield in the bottom right corner of Report Pro, the vehicle shown needs this utility run. Don’t worry, 
there is no need to unpost/repost the history invoice needing the correction. Note that this should not be used for cases 
where two vehicles history are blended together by improper vehicle editing, usually when the same license plate returns on a 
new vehicle and the user changes the Year Make Model instead of entering a new vehicle 

1. Select the tools tab 
2. Select the Odometer Fix button 
3. Highlight the invoice date with the improper mileage entry 
4. Enter the correct In and Out mileages for that invoice date 
5. Select the Update button 
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Customize Multi Point Inspection with Mobile Manager Subscription 

What you should do before customizing 
1. Make a list of categories that represent the service lines that you wish to dynamically track against your shop management 

invoice line items. 
2. Typically these are recurring maintenance services such as Oil Change, Transmission Service, Coolant Service, Front Brake 

Service, Rear Brake Service, Tire Rotation, and Air Filter etc... 
3. As a general guideline, there should be AT LEAST one category for each separate service you wish to track dynamically 
4. Compare your list of categories with the list of categories that you already have in your shop management system 
5. Missing Categories should be created in your shop management system 
6. Any category that applies to more than one service should be edited to represent only a single service. [Hint] Make note of 

those categories for help when using Category Tools to reassign your history line items 
7. Make a list of all inspection lines that you could possibly perform for every type of inspection you could possibly perform. While 

creating each line, think about all of the typical notes and recommended actions that happen for each of those inspection 
lines. Doing this will allow for a more rapid creation of your Digital Multi Point Inspections 

Definitions 
1. Inspection Title – The name of the inspection being created or viewed 
2. Associated Category - The category in your shop management system that applies to Parts, Labor, and Sublet line items on 

your invoices. If you do not see your desired category in the drop down list, create it in your Shop Management System 
3. Group - Allows for grouping line items on the M.P. Inspection report into sections 
4. Point Title/Description - The description of the inspection line item as it will display and render on the digital multi point 
5. Month Interval - Maximum number of months that should elapse before the inspection/service needs to be performed again 
6. Odometer Interval - Maximum number of miles/kilometers that should elapse before the inspection/service needs to be 

performed again 
7. Canned Jobs – The list of canned jobs that are available in your shop management system 
8. Canned Recs – the list of canned recommendation descriptions for the highlighted inspection point 
9. Canned Notes – the list of canned note descriptions for the highlighted inspection point. This is also the place that you can 

build your pick list of values for measured items such as Brakes & Tires 

Hints 
1. If a service is only tracked on a months due back basis, enter 0 for the Miles Due Back 
2. If an inspection happens every time a vehicle is in and does not have a corresponding line item on an invoice, select <No 

Category> from the Shop Management Category drop-down 
3. Be sure to load your Shop Logo on your invoices in Report Pro as it is also the logo that will brand the Digital Multi Point 

Inspection Page that your customers will go to during the review process with your service advisor 
4. Make a list of all inspection lines that you could possibly perform for every type of inspection you could possibly perform. 

While creating each line, think about all of the typical notes and recommended actions that happen for each of those 
inspection lines. Doing this will allow for rapid creation of your Digital Multi Point Inspections 

Build a Digital Multi Point Inspection 
1. From Report Pro 
2. Select the Customize Tab 
3. Select the Customize M.P. Inspection button (The Inspections window opens displaying a list of your available inspections) 
4. Select the Points Editor button (The Points Editor windows opens displaying a list of your inspection points, grouped by the 

shop management system category that they are linked to) 
5. Highlight an existing point in the left pane. Its details are shown in the right pane on the General Tab. In the right pane 

5.1. Edit the Point Title/Description 
5.2. If you would like to dynamically track the item to identify the last performed date and odometer, link it to an Associated 

Category from your management system. Keep in mind that the last date and odometer is for the last time that Category 
was performed, so if your categories are not specific (one to one) for the service, select the <No Category> option 

5.3. Enter a Month Interval that this item recurs on 
5.4. Enter an Odometer Interval that this item recurs on 
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6. Select the Canned Jobs tab to link canned jobs from your management system to the inspection line item. When there are 

canned jobs linked to a line item when it fails, the list of those canned jobs are presented to the tech for which one applies to 
correct the failure. When selected it is automatically added as declined work in your shop management system 
6.1. Check each canned job that represents a correction to the corresponding failed line item 

7. Select the Canned Recs tab 
7.1. Select the Add button. The canned item window opens. Typically, each line item will have two canned recommendations, 

one that represents a Due Soon (Yellow) and one that represents a Due Now (Red) scenario. 
7.1.1. Enter a name for the canned recommendation. This is the name that will be available in the Digital Multi Point 

Inspection for the technician to choose when performing the inspection 
7.1.2. Add a recommendation description for the inspection line. You should make the description professional and 

informative as it adds to the value when presented to the customer. These are important and will prevent you or 
your techs from typing the same thing over and over and will also standardize your presentation to the customer no 
matter who makes the recommendation 

7.1.3. Optionally link the recommendation to a color by checking the box next to the corresponding color. Linking it to 
Yellow will make it auto-populate on the Digital Multi Point inspection when the yellow box is checked for that line 
item. Likewise, linking it to red will make it auto-populate on the Digital Multi Point Inspection when the red box is 
checked for that line item. 

7.1.3.1. Checking both colors will make it auto populate when either the yellow or red box is selected for that line 
item 

7.1.3.2. Select the OK button 
7.1.4. Repeat steps 7.1. - 7.1.3.2. until you have created all the canned recommendations for that line item 

8. Select the Canned Notes tab 
8.1. Select the Add button. The canned item window opens. Use this area to create the common observations made for this 

inspection line item. This could be in the form of a note or could be in the form of a pick list of measurements as common 
for a brake inspection 

8.1.1. Enter a name for the canned note. This is the name that will be available in the Digital Multi Point Inspection for the 
technician to choose when performing the inspection 

8.1.2. Add the note description for the inspection line. You should make the description professional and informative as it 
adds to the value when presented to the customer, no matter who adds the note 

8.1.3. Select the OK button 
8.1.4. Repeat steps 8.1. - 8.1.3. until you have created all the canned notes for that line item 

9. Close the Points Editor window 
10. Select the Add Inspection button to create a new inspection. 

10.1. Double Click an existing inspection to edit it. 
10.2. Highlight and existing inspection and select the Delete button to delete an inspection. (Please note that deleting an 

inspection cannot be undone) 
11. In the Inspection Title box, give your inspection a Title 
12. Select the New Group button at the bottom of the Inspection Editor window. The Group window opens. Do not skip this step 

since inspection line items must have a group 
13. Select the Group Name from the drop down box of previously used groups. If you do not see your desired group name, type a 

new name in the drop down box. (Note, this is not the place to edit your group name. Editing the name here will create a new 
group and cause you to have duplicates. If you want to edit the group name, do so by Double Clicking the group name from 
the Inspection Editor after adding it to the inspection) 

14. Repeat steps 12 13 for each group you would like to add to the inspection. When you have finished adding your groups, 
continue to the next step 

15. On the left window pane, highlight the group you would like to add inspection lines to 
16.  On the right window pane, lines with a green check have already been added to the inspection. Double Click lines without a 

green check mark to add them to the highlighted group. Double Click lines with a green check to remove them from the 
inspection 

17. Repeat steps 15 – 16 to fill each group with inspection lines 

Customize Parts Profit 
Under the Accounting folder is a Parts Profit with Excluded Categories. Use the Customize Parts Profit to segregate selected 
categories from the general parts profit. This will create 3 sections for parts profit calculation, one for parts except where the 
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category is segregated, one for the segregated categories and one for the overall. A couple common categories that are useful to 
exclude are Tires and Batteries due to the typically low markup associated with them 
1. From Report Pro 
2. Select the Customize Tab 
3. Select the Customize Parts Profit button (the Customize Parts Profit window opens) 
4. Select the categories that you wish to segregate in the Parts Profit with Excluded Categories report 
5. Select OK 

Inspection Manager 

Use Query Builder 
1. From Report Pro 
2. Select the Tools tab 
3. Select the Query Builder button (a new window opens) 
4. Select a query by Double Clicking its name or 
5. Select the “Or Select here to define a new query” button (a new window opens) 
6. Give the Query a name and a description 
7. Using the object selection tree on the bottom left, Select the fields you would like your report to contain by expanding the table 

name and Double Clicking the fields one at a time 
8. Once you have added all the fields to your report Select the Save button 
9. Reopen the report by Double Clicking its name to add sort and filter criteria 
10. Set the sort for your report by selecting the Sort Arg dropdown for each field. ASC is ascending order and DESC is descending 

order 
11. Set the filter criteria for your report by selecting the Criteria button for each field you would like to filter by. Options are: 

11.1. Equals 
11.2. Greater Than / Less Than 
11.3. Not Equal To 

12. Select the Save button to save your report 
13. Reopen the report by Double Clicking its name 
14. Select the Export button to Run the report and save it to your computer (a new window opens to allow you save it) Be sure to 

remember its location 
15. Open your saved report in MS Excel or the spreadsheet viewer of your choice 

Register Tires 
We’ve aggregated the top tire brands registration sites in to an easy to use portal in which Report Pro will auto populate the 
website form with as much info from your management system that it can link to in the tire registration form 
1. From Report Pro when an Invoice is open in your management system 
2. Select the Tools tab 
3. Select the Register Tires button (A new windows opens) 
4. Select the brand of tires that you need to register 
5. The selected brands tire registration page opens and is prefilled with all data that could be auto determined 
6. Verify/Edit the data that was auto populated 
7. Complete any missing data 
8. Follow the websites instructions for submitting the registration data 

Restructure history line item categories 

Unassign history line item categories 
When preparing for linking your line items to a standard service category, you may have line items assigned to a category that is 
too broad, in which those line items need to be reassigned to their new service category. Follow these steps to first unassign these 
line items from their category to allow for them to be reassigned to their new service category  
1. From Report Pro 
2. Select the Tools tab 
3. Select the Category Tools button (a new window opens) 
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4. Select the Unassign Categories tab 
5. Before continuing, be sure that you want to Unassign these categories that you select since the action is not reversible 
6. Select the category that line items need to be unassigned from. Optionally you can multi-select by using the CTRL+Select 
7. Select the Unassign All Line Items From This Category button 

Assign history line items to a new category 
1. From Report Pro 
2. Select the Tools tab 
3. Select the Category Tools button (a new window opens) 
4. Select the Assign Categories tab 
5. Enter a text string to search line item descriptions for a match. Example: If you want to assign your “Brake Service – Front” 

category and your line item description for that service is “Replace front disc pads” then enter “Replace front disc” as the text 
to match. You may need to perform a couple iterations of text to match on due to inconsistencies in your data entry for 
descriptions. 

6. Select the Search button. All line items that do not have a category assigned to them will be loaded in the results window below 
the search box sorted by most to least 

7. Scroll to the top of the search results 
8. Begin selecting the line items that you want to assign to the same category. Use the CTRL+Select option to select multiple lines. 
9. Be sure that you want to assign the selected line items to the same category 
10. When finished selecting line items, Right Select in the results to expose a list of your management systems categories 
11. Locate the category in the list that you would like to assign them to. If your list is long, use caution when selecting the down or 

up arrows as to not accidentally select a category from the list as this action is not reversible 
12. Select the category that you would like the selected line items assigned to 
13. Repeat steps 5-12 for each string/category that you need to match/assign 

Fix history odometer readings 
There are two ways to get to the Odometer Fix for a vehicle. 

Manually 
1. From your management system 
2. Open a vehicle that has incorrect odometers in its history 
3. From Report Pro 
4. Select the Tools tab 
5. Select the Odometer Fix button (a new window opens with dates and odometer readings) 
6. Scroll to the Date/Odometer readings that need to be fixed 
7. If Report Pro thinks it needs attention, the line will be highlighted 
8. Select the line that you would like to fix. Report Pro will guess what it thinks the odometer readings were on that date based on 

the vehicles average daily mileage 
9. Verify or Enter the Odometer In and Odometer Out values 
10. Select the Update button 
11. Repeat steps 6-10 for each history record that needs to be repaired 
12. Select the Exit button when completed 

When Report Pro has identified an issue 
When an Invoice or Report is loaded for a vehicle and Report Pro has identified a possible issue with the Odometer readings for a 
vehicle, a yellow shield will display on the bottom right side of the Report Pro window 
1. Select the yellow shield (a new window opens with dates and odometer readings) 
2. Scroll to the Date/Odometer readings that need to be fixed 
3. If Report Pro thinks it needs attention, the line will be highlighted 
4. Select the line that you would like to fix. Report Pro will guess what it thinks the odometer readings were on that date based on 

the vehicles average daily mileage 
5. Verify or Enter the Odometer In and Odometer Out values 
6. Select the Update button 
7. Repeat steps 2-6 for each history record that needs to be repaired 
8. Select the Exit button when completed 
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Configure Custom Commissions Report 

Using the Goodyear Point of Sale 

Send sales data to Goodyear 
Be sure that your Report Pro email settings are configured and working so the report is delivered successfully. See Configure my 
email settings  
1. From Report Pro 
2. Select the Tool tab 
3. Select the Goodyear Point Of Sale button 
4. Select the Goodyear Report tab 
5. Enter your date range 
6. Enter your Goodyear Non-Sig number (Only needed the first time, Report Pro remembers it the next time) 
7. Select the Create Report button 
The report will be generated in the Goodyear format, saved to C:\BOT\GOODYEAR\ folder and automatically submitted to 
Goodyear via email. Report Pro does not know the status of your 1% back, please request this info from Goodyear. 

Import Goodyear Price List 

Tire Sales Report (AKA: Spiff Report) 

Move Vehicle History 
This tool allows for the history of a vehicle to be moved to a new vehicle in the event that two vehicles history was combined 
without the need to unpost and repost the invoice in the management system. Typically this happens when a user has changed 
the year make model of a vehicle when the vehicle owner purchased a new vehicle and transferred their tag to the new vehicle. 
Please note that this moves history records for the vehicle. If the order is still in your Work in Progress, you can change the vehicle  
1. From your management system 
2. Create a new vehicle under the customer with the all the vehicle information. This will generate a new vehicle id in the 

management system to move the vehicle history to. 
3. Open the incorrect vehicle and change the Vehicle data back to the original vehicle data 

Please note that there may not be any reference data in your management system to know what the original vehicle data 
was. If this reference data is not available in your management system, use good ole memory or lookup via the printed paper 
copy from your signed records. 

4. From Report Pro 
5. Select the Tools tab 
6. Select the Move Vehicle History button 
7. Select the look up button in Step 1: Select FROM Vehicle 

7.1. Lookup the vehicle by Customer Name, Phone (Last 4) or License 
7.2. Select the vehicle from the results list to populate the FROM vehicle 

8. Select the Starting Point of Service History To Transfer 
9. Select the lookup button in Step 3: Select TO Vehicle 

9.1. Lookup the vehicle by Customer Name, Phone (Last 4) or License 
9.2. Select the vehicle from the results list to populate the TO vehicle 

10. Select the Perform History Transfer button 
The history for the selected records has now been moved to the new vehicle 

Use the Price List Import 
This tool will update parts in your management system inventory as well as insert new parts if the option is selected. Due to this it 
is extremely important to follow the steps exactly as follows. Do not skip any of the steps and refrain from data entry of any type 
until the verification step has been performed. This price list import utility reads part numbers, descriptions, costs, prices, and 
other details from an Excel workbook with the file extension “.xlsx”.  The workbook may contain more than 1 worksheet. The idea 
is to supply a column name for each property of a part which is handled by this utility. Since not all values will always be listed in 
the spreadsheet, it is possible to specify a single default value for each property. Default values are only used when there is no 
mapped column name.  
If there is more than 1 worksheet in the workbook, the utility will read them all. The column names for any mapped properties 



How Do I 
 
must be the same on all worksheets. 
Because some Excel workbooks have been supplied where the column header takes up more than 1 row of data, it is necessary to 
enter the number rows that the header data uses on the first screen of the import utility, if more than 1 row is used. 
There are 3 different pages where column names can be mapped or default values provided. The column names from the 
worksheet are displayed to the right of the inventory properties. Column names can be dragged-and-dropped. If the column 
names in the displays appear wrong, check that the correct number of rows of header data was entered on the first page. 

Option Definitions 
 How unique parts are matched for insert or update: A unique part is identified by the combination of the Part Number 

and the Manufacturer. Parts that exist in your management system that match the Part Number Manufacturer 
combination from your spreadsheet will have the mapped values from your import mapping definition updated in your 
Shop Management System to the values of the spreadsheet. If selected, unmatched parts on Part Number and 
Manufacturer will be inserted in to your inventory.  

 Remove embedded dashes from input part numbers: Often times, suppliers will provide spreadsheets in which the part 
numbers that they supply contain dashes (-). Check this option to have those dashes ignored/removed during the import. 

 Insert new part numbers into inventory: Check this option if you would like all new parts from the spreadsheet to be 
inserted. Remember that if the Part Number and Manufacturer do not match an existing Part Number and Manufacturer 
in your Management System, it will be inserted as a new part. There is no undo option for this if a mistake is made in the 
mapping file or import process. The only option is to restore your database to the backup that you perform before 
performing the import. 

 A Part Number is required. We treat the combination of part number and Manufacturer as unique. If a part 
number/manufacturer is encountered more than once in the input, the 2nd instance will be processed as an update to the 
part number. A blank Manufacturer is possible which could cause a duplicate to be entered or updated in your 
Management System because the combination of both part number and manufacturer are unique. For example: If the 
inventory in your Management System has the following part - Part Number: AF-12345, Description: Air Filter, 
Manufacturer: Fram and your spreadsheet for import contains - Part Number: AF-12345, Description: Air Filter, 
Manufacturer:        , then the part line from the spreadsheet will be inserted as a new inventory part since the 
manufacturer is different 

 A Part Description is also required 

 If a part number/manufacturer already exists in the database, the input is treated as an update. The following properties 
can be updated: Part Description, Size, Cost, Selling Price, List Price, GL Account Code, Category, tire flag, taxable flag, and 
user entered price flag 

 For GL Account codes, the mapped column in the spreadsheet can contain the unique database id for the Income Account 
being associated with the part. Most users will choose not to map this column, but select a default from the selection tool 
provided in the “Default if not mapped” column 

 For Categories, the mapped column in the spreadsheet can contain 
o the unique database id for the category or  
o The category description as entered in the database 

For Vendors and Manufacturers, the mapped column in the spreadsheet can contain 1) the unique database id of the Vendor or 
Manufacturer, 2) the code as entered in the database for the Vendor / Manufacturer, or 3) the name as entered in the database 
for the Vendor / Manufacturer 
Please note that Manufacturers and Vendors for a part are only set during insert. Due to system requirements, it is not possible to 
update them automatically. 

 On the page titled “Data Columns with True / False defaults”, the property “Is this item a tire?” corresponds to the Tire 
checkbox in the Inventory – Edit Part screen. A mapped column of data for this property may contain “1”,  “true”, or “yes” 
for checked, and “0”, “false”, or “no” for unchecked 

 On the same page, the “Taxable Y/N?” and “Tax Exempt Y/N?” properties correspond to the Taxable checkbox. The 
“Taxable Y/N?” value maps to the check box with the same values as for “Is this item a tire?” The “Tax Exempt Y/N?” value 
maps to the check box with the opposite properties. If a default value is required, set the value in the “Default if not 
mapped” column for the “Taxable Y/N?” property 

 “User Entered Price Y/N?” corresponds to the “User Entered Price $” checkbox in the Inventory – Edit Part screen. 
Mapped column values are same as for “Is this item a tire?”  
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Steps by Step Configuration 

1. From your management system host computer 
2. Create a backup of your database 
3. Verify that the backup was successful. Often times your setting may be set to backup to an external drive and if that 

external drive is not connected, the backup will fail. 
4. From Report Pro 
5. Select the Tools tab 
6. Select the Price List Import button 

The Price List Import window opens 
7. If you want to keep embedded dashes in your part numbers, uncheck the box next to Remove embedded dashes from 

input part numbers, otherwise, leave it checked 
8. If you want to insert new parts from your spreadsheet, check the box next to Insert new part numbers into inventory 
9. At the bottom of the screen, Enter the number of rows that your input workbook uses. Examples are below: 
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9.2. 2 Header Rows 
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10. Select the Select Price List button 
A Windows Explorer window opens to navigate to the .xlsx file you would like to import 

11. Navigate to and select the file you would like to import 
Please note that you cannot have the spreadsheet open while trying to import it 

12. Select the Open button 
13. Verify that the sample data on screen appears correctly 

If it does not, verify the number of header rows from your source file 
14. Select the Next Step button in the lower right corner 

A new screen is loaded that has three sections. The top left grid contains basic part description information with mapped 
values from your source spreadsheet and a default value to be set if the field is not mapped. The bottom left grid 
contains inventory price information with mapped values from your source spreadsheet and a default value to be set if 
the field is not mapped. Typically this is zero because it applies to multiple parts. The right section is the list of fields in 
the header row(s) of your source spreadsheet that can be used as reference for entering the Input Column Header, 
however, we suggest using the drag and drop feature. 

15. Drag your source field from the right section to one of the rows in the left sections to populate your Input Column 
Header map. 
15.1. Repeat this for each field you would like to map 

16. Set a default value if not mapped for each of the fields. 
Most times on this step you will have a mapped value for each of the fields, so no default is necessary. 

17. Verify your mapping for these fields and make edits if necessary 
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18. Select the Next Step button to continue 
A new window opens with two sections to set the relational items to your inventory records. The left section is your 
mapped values from your source data with default value if not mapped. The right section is the list of fields in the header 
row(s) of your source spreadsheet. 

19. Drag your source field from the right section to one of the rows in the left section to populate your Input Column Header 
19.1. Repeat this for each field you would like to map 

20. Select a default value if not mapped for each of the fields 
21. Verify your mapping for these fields and make edits if necessary 
22. Select the Next Step button to continue 

A new window opens with two sections to set the default flags for the inventory item. The left section is your mapped 
values from your source data with default value if not mapped. The right section is the list of fields in the header row(s) 
of your source spreadsheet 

23. Drag your source field from the right section to one of the rows in the left section to populate your Input Column Header 
23.1. Repeat this for each field you would like to map 

24. Select a default value if not mapped for each of the fields 
25. Verify your mapping for these fields and make edits if necessary 
26. Verify that you have backed up your Shop Management Systems database and no new data has been entered to it 
27. Select the Process Excel Workbook 

A new window opens that displays the progress of the import process. 
28. If there were exceptions during the process 

28.1. Select the View Exceptions button 
28.2. Review the exceptions 
28.3. Make updates to your Management System, Source Spreadsheet and/or Your mapping file and reprocess if 

necessary 
28.4. Optionally save the results to a file for review in a spreadsheet or at a later time 

29. Verify that the inventory records that were updated/inserted, were done so correctly before resuming data entry in to 
your system 
29.1. If you find that the import did not perform the updates correctly, restore your database to the backed up version. 
29.2. If you find that the import did perform the updates correctly, resume data entry to your system 

30. Once data entry resumes, if you discover an issue, the only options are to restore to the last backup or make the 
corrections one at a time 

Setup Quick Reports 
Setting is per machine. This allows for some creative implementation to address the needs of different types of customers. Once 
you have determined which of the Invoice Templates your preferred template is and which two vehicle reports you would like to 
print for Repair Orders, follow these steps to unlock the Quick Invoice and Quick Vehicle buttons on the Home Tab Ribbon. 
1. From Report Pro 
2. Select the Settings tab 
3. Select the Quick Reports button 
4. Select the Quick Invoice tab 
5. Select Your Preferred Invoice template from the drop down 
6. Select Your Preferred Printer from the drop down 
7. Set your preferred Number of Copies to print out (HINT: Set this to 1 and keep your management systems print out for your 

records. This allows for your current process to continue with your management system applying its workflow for approving 
parts, reducing inventory and marking the invoice printed while providing your customer with a great invoice) 

8. Select the Quick Vehicle tab 
9. Select Your Preferred Vehicle Report from the drop down (Typically the Tech Worksheet) 

Select Your Preferred Vehicle Report 2 from the drop down (Typically the Only Show Labor Lines 
Selecting this option will not show parts info 
10. Customize Multi Point Inspection if you have set it up) 
11. Select Your preferred Printer from the drop down (Can be sent to a different printer than the invoice) 
12. Set your preferred Number of Copies 
13. Select the Save button 
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Configure the Custom Commission Report 
Use this report to help you calculate the exceptions in commissions paid on parts, less sales tax, shop fees, and sublets. The 
exception is parts that cost you over the configured cost. If the part cost less than the configured cost, the commission would be 
paid on the entire sale price. Example; your configured cost threshold is $50.00 and your cost is $49.00, you sell it at $100.00 and 
the technician was on a 20% he would be paid $20.00. If the part costs more than the configured cost, the technician would be 
paid on the profit of the part. Example; your configured cost threshold is $50.00 and your cost is $51.00, you sell the part for 
$100.00 the technician was on a 20% he would be paid on the $49.00 profit at 20% he would make $9.80. This helps protect you 
from the more expensive parts and provides incentive to your employees to research and find the best possible cost pricing 
because the most profitable items are usually the smaller maintenance parts. This allows your technician to be rewarded for 
finding and recommending these small items that normally do not have a lot of labor added to them. If they are paid on just labor 
these items will get overlooked. 
1. From Report Pro 
2. Select the Tools Tab 
3. Select the Custom Commission Report button 
4. Enter the cost threshold (under/over $ amount) in the Threshold Dollars box 
5. Double Click the Technicians name in the list (a new window opens) 
6. Enter the parts commission % for the technician 
7. Select the OK button 
8. Repeat steps 5 – 7 for each technician 
9. When finished, Select the Save button 
10. The report is available in the Accounting folder (Left panel Navigation) 

10.1. Select the Custom Commission Report in the Left Panel Navigation 
10.2. Expand the Parameters Ribbon footer (gray bar at bottom of report pro screen) 
10.3. Enter the Date Range for rendering the report 
10.4. Select the Refresh button (two opposing blue arrows) or The Reload button in the Home Ribbon or the F5 key on your 

keyboard to render the report for the entered date range 

Set the Location to the Report Directory 
This is automatically set to the default C:\BOT\Reports\. Report Pro will prompt for the location of the Reports folder when the OS 
(Operating System) is not installed on the C:\ drive or if an Anti-Virus program has quarantined a file. If the Anti-Virus quarantined 
file(s), those file(s) must be restored before the location path can be reset. 

Configure my email settings 
Each machine is configured separately and you can use the same email on all workstations or different, it’s your choice.  Email is 
sent using SMTP via your email provider. Many email servers do not place a copy of SMTP sent mail in your Sent folder, Report Pro 
cannot force this to happen. The alternative option is to use the default email client on your computer. 

Using the default email client on your computer 
1. From Report Pro 
2. Select the Settings tab 
3. Select the Email Settings button 
4. Check the box Use Default Mail Instead (Outlook, Windows Mail, etc...) 
5. Select the Save Button+ 

5.1. ***NOTE that using this option does not allow for email addresses entered in the To field of the email to be saved back to 
the customer record in your Shop Management system 

Using SMTP (Simple Mail Transfer Protocol) 
1. From Report Pro 
2. Select the Settings tab 
3. Select the Email Settings button 
4. Select your provider from the dropdown list of common providers or select Custom 
5. Verify or enter the Host for your provider (This is the outgoing SMTP Host of your email service provider) 
6. Verify or Enter the SMTP port number (This is the outgoing SMTP Port of your email service provider) 
7. Check the box Secure Connection if your email provider requires a secure connection 
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8. Enter your Email Address 
9. Enter the password you use to login to your email 
10. Enter your preferred display name for who the email is From. Some email servers require this to match your email address for 

authentication 
11. Enter the Default Email Body. This can be a short message and or signature. Messages sent without any message body are 

likely to get flagged as spam 
12. Select the Save button 
13. Send a test email 

Prompt for customer email on invoice load 
Use this feature when capturing emails for customers is on your high priority list. It may be a little over-bearing for daily use, but 
gets the point across to you or your service advisor when capturing email addresses is an absolute must for your business. Keep in 
mind that when sending an email via Report Pro, if no email address exists, the user will be prompted to save the email address 
back to the customer record (Not when Use Default Mail Client Instead is selected) 
1. From Report Pro 
2. Select the Settings tab 
3. Select the Email Settings button 
4. Check the box next to Prompt for customer email on invoice load 

Send cc to shop’s email address 
This does not apply when Use Default Mail Client Instead is selected. Your email service provider should automatically save a copy 
of mail sent via Simple Mail Transfer Protocol (SMTP) to your sent folder on the email server. If you find that your email service 
provider is not doing this, use this alternate method of CC’ing yourself instead. Using this option will copy the email address 
configured to send from. 
1. From Report Pro 
2. Select the Settings tab 
3. Select the Email Settings button 
4. Check the box next to Send cc to Shop’s email address 

Apply Shop Management Settings 
This is where you select your management system and the ODBC connection to your management system. Typically you do not 
need to change these settings as they are applied for you during installation. 

Message Manager Pro 

Where did my Message Pro screen go? 
Message Pro is designed to start when your computer starts so the service should still be running. Once you have opened 
Message Manager Pro for the day, keep it open on your Task Bar (that’s the bar at the bottom of your computer screen that 
shows the icons of programs that you have open). If you do not see the Message Pro icon on your task bar, follow these simple 
steps to get it back 
1. Expand the icons in your system tray by Selecting the arrow that is next to it. If no arrow is there, proceed to step 2. (Your 

system tray is the list of icons for services running and is located by your computers clock. Typically the lower right corner of 
your screen) 

2. Right Select the Message Pro icon (it’s a wrench with a grey square around it). 
3. Select the Message Manager option from its menu. The Message Pro window opens 

Activate Message Manager Pro 

From your activation email 
1. Open your email that contains your SMS Number and Activation code 
2. Highlight your Activation code and copy it via CTRL+C or Right Select/Copy 
3. Select the Pro Pack button 
4. Select the Message Manager Pro button 
5. Select OK in the dialogue prompt that says “There was a problem with activation key” 
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6. Type in your SMS number in the fields under Your Message Manager Number 
7. Select in the box under Activation Key and paste your activation key via CTRL+V or Right Select/Paste 
8. Select the Save button 

With the Get Key feature 
1. From Message Pro 
2. Select the Settings tab 

The settings window opens 
3. Select the Messaging tab 
4. Select the Get Key button 

The verify your shop email address window opens 
5. Enter the email address for your shop 

The email address must match the email address that we have on file for you 
6. Select OK 

Your SMS number and activation key will populate 
7. Select the Save button 

Remove Message Manager from Startup 
1. Select the Start button 
2. Select/Expand All Programs 
3. Select/Expand the Startup folder 
4. Right Select Message Manager Pro 
5. Select Delete 

Select or Change the phone number Message Manager Pro links to 
Please note that if you change the linked description in your management system, Message Pro will need to be updated with the 
new setting 
1. From your Message Manager Pro window 
2. Select the Settings tab 
3. Select the Setup tab 
4. In the box under Primary Cell Phone, Select the drop down arrow 
5. Select the Phone Label that applies to your cell number in your management system 

5.1. Optionally set a Secondary Cell Phone. Secondary Cell Phone is only used to check incoming messages for cases when 
Primary Cell Phone forwards to Secondary Cell Phone and Secondary Cell Phone replies directly to your SMS number 

6. Select the save button 

Increase the number of messages displayed in my messages window 
1. From your Message Manager Pro window 
2. Select the Settings tab 
3. Select the Messaging tab 
4. In the box under Max Messages Displayed, increase it to your preferred number 
5. Select the Save button 

Send auto reminder text messages for appointments 
From the computer where most communication/interaction occurs with the customer 
1. From your Message Manager Pro window 
2. Select the Settings tab 
3. Select the Automation tab 
4. Check the box labeled Send Auto Text Message Reminders From This Computer 

4.1. Only ONE computer should have this set, otherwise customers will receive a reminder from every computer 
5. In the box under Send At, set the time of day that the reminder will be sent 
6. In the box under Days In Advance, set the number of days before the appointment that the reminder will be sent 
7. In the box under Message is the message template that will be used when sending the reminder 

7.1. Select the Load From Templates button 
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7.2. Select the Message Template to load to the reminder box 
7.3. Select the OK button 

8. Select the Save button 

Force Explicit Opt In for Text Communication 
In October of 2013, the FCC passed a law that classifies business to consumer text communication as either Transactional or 
Promotional. Message Pro is designed and functions as a communication tool using transactional messages as the messages 
revolve around an existing Repair Order or Future Appointment. If you intend to use Message Pro in a promotional manner, such 
as sending texts for previously declined work, service recommendations or “Promotional Offers” you must turn on the Opt In 
feature. Using this is not recommended as it is not the intended purpose of Message Pro and can greatly reduce the efficiency of 
its intended purpose. If you would still like to send Promotional Messages, follow the steps below to have your customers Opt In 
to receiving promotional offers from you via Message Manager Pro 
1. From the Message Manager Pro window 
2. Select the Settings tab 
3. Select the Opt In tab 
4. Check the box next to “Require Customers To Opt IN To Text Message Reminders” 
5. Enter the message in the “Opt In Message” box that you would like your customers to receive. The default message is for 

opting in to appointment reminders, be sure to adjust the message to indicate opt in for promotional offers 

Auto label appointments as confirmed 
1. From your Message Manager Pro window 
2. Select the Settings tab 
3. Select the Automation tab 
4. Check the box labeled Customer Can Reply C to Confirm Appointment. 
5. Verify/Edit the label to prefix to the appointment notes field in your management system 

5.1. When a customer replies the letter C to the appointment reminder, the notes field of their appointment will be prefixed 
with this label. This provides better visibility in to whether appointments are confirmed. Best practice would be for your 
service writers to use the same label when booking appointments outside of the automation 

6. Select the Save button 

Create/edit text message templates 
The Template Builder has three vertical panels. The left panel displays a list of your templates. The middle panel displays the 
Message Title and Message body. The right panel displays a list of Merge Tags. 
1. From your Message Manager Pro window 
2. Select the Settings tab 
3. Select the Setup tab 
4. Select the Message Template Builder button 
5. Select the Template you would like to edit or Select the Add button to create a new template 
6. Edit the Title of the template 
7. Type a message for the template. Be sure to use the optional database parameters to personalize your template 

7.1. Be sure to include the [ReplyToConfirm] [OptOut] parameters for your auto reminders 
7.2. Be sure to include “Reply [OptOut]” for your other templates 

8. Select the Save button 
9. Select the Close X 
10. Select the Close X 
11. Select the Save button 

Include Unit# in Vehicle description in text message 
If you primarily service fleets, this is a great option to turn on as it will communicate to the fleet manager, the specific vehicle that 
is due for service 
1. From Message Manager Pro 
2. Select the Settings tab (The settings window opens) 
3. In the settings window 
4. Select the Setup tab 
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5. Check the Option Include Unit # in Vehicle Descr in Text Msg 
6. Select the Save button 

Now in addition to Year Make and Model, the Unit Number of the vehicle will also be included 

Include License Plate in Vehicle description in text message 
If you service fleets or have customers with several of the same Year Make Model, this is a great option to turn on as it will 
communicate to the customer, the specific vehicle that is due for service 
1. From Message Manager Pro 
2. Select the Settings tab (The settings window opens) 
3. In the settings window 
4. Select the Setup tab 
5. Check the Option Include License Plate in Vehicle Descr in Text Msg 
6. Select the Save button 

Now in addition to Year Make and Model, the License Plate of the vehicle will also be included 

Include Appointment Time with Date in text message 
Whether you’re just starting or have already transitioned your customers to setting the next appointment, adding the time of the 
appointment to the reminder is a great option. 
RECOMMENDATION: Be sure to plan your schedule a couple weeks in advance to get the time more accurate. Lube Sticker Pro can 
auto increment time between appointments, but does not replace the planning needed for a scheduled day. 
1. From Message Manager Pro 
2. Select the Settings tab (The settings window opens) 
3. In the settings window 
4. Select the Setup tab 
5. Check the Option Include Appointment Time in Vehicle Descr in Text Msg 
6. Select the Save button 

Now in addition to the Appointment Date, the Appointment Time will also be included 

Send a text message 
There several ways to get to the send message screen 

With a Customer/Vehicle/Order open in your shop management system 
1. From Message Manager Pro 

1.1. Select the Quick Message button 
1.2. Select the message template from the Quick Template window or type your message in the message box at the bottom 
1.3. Select the Send button 

Double Click a message in your Messages window in Message Manager Pro 
1. From Message Manager Pro 

1.1. Select the Messages button to display the Messages screen 
1.2. Double Click the Message you would like to reply to 
1.3. Verify in the conversation history window that someone else has not already replied to the message 
1.4. Select the message template from the Quick Template window or type your message in the message box at the bottom 
1.5. Select the Send button 

From the desktop notification message box 
1. Select the desktop notification 

1.1. Verify in the conversation history window that someone else has not already replied to the message 
1.2. Select the message template from the Quick Template window or type your message in the message box at the bottom 
1.3. Select the Send button 

From the Work In Progress display in Message Manager Pro 
1. From Message Manager Pro 

1.1. Select the Management button 
1.2. Double Click the customer in the Work In Progress display window 
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1.3. Verify in the conversation history window that someone else has not already sent the message 
1.4. Select the message template from the Quick Template window or type your message in the message box at the bottom 
1.5. Select the Send button 

From the schedule display in Message Manager Pro 
1. From Message Manager Pro 

1.1. Select the Management button 
1.2. Select a date in the Calendar window 
1.3. Double Click an item in the Schedule window 
1.4. Verify in the conversation history window that someone else has not already sent the message 
1.5. Select the message template from the Quick Template window or type your message in the message box at the bottom 
1.6. Select the Send button 

From the Contacts lookup button in Message Manager Pro 
1. From Message Manager Pro 

1.1. Select the Contacts button 
1.2. Select the radio button for whether to search Customers or Companies 
1.3. Use the scroll wheel to select the letter to display search results 
1.4. Double Click the Customer/Company in the results list 
1.5. Verify in the conversation history window that someone else has not already sent the message 
1.6. Select the message template from the Quick Template window or type your message in the message box at the bottom 
1.7. Select the Send button 

Select the New Message button 
1. From Message Manager Pro 

1.1. Select the New Message button 
1.2. Type in the cell number in the top box 
1.3. Type in your text message in the bottom box 
1.4. Select the send button 

Print text message history for a phone number 
1. From Message Manager Pro 

1.1. Use any of methods 1 through 6 in Send a text message to open a conversation window 
1.2. Select the Print Conversation tab. Communication history is displayed in notepad 
1.3. Select File in the upper left corner of the notepad screen 
1.4. Select Print from the menu 
1.5. Select your printer from the printer list 
1.6. Select the Print button 

Open My Team Chat window 
If you are a Mobile Manager user, Message Manager will display the Team Chat button on the Home ribbon. 
1. From the Home tab in Message Manager 
2. Select the Team Chat button 
3. A new window opens in the lower left corner of your screen displaying your Team Chat communication 

Communicate via Team Chat 
1. From the Team Chat window 
2. Select your user from the drop down. This is a drop down menu of employees as configured in your shop management system 
3. Type your message in the box to the right of your name 
4. Select the send button (arrow) to the right of the message box 

Mobile Manager Pro 
Select this option to configure the settings that are needed to perform the different features of Mobile Manager Pro. 
1. Touch the Options Menu button to expose its menu option 
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2. Select the Settings option from the menu 

Server Configuration 
These can be found using the Mobile Manager Config tool on your server. 

2.1. Open Windows Explorer 
2.2. Navigate to C:\BOT\ 
2.3. Locate and Double Click the MobileConfig.exe (The Mobile Manager Setup Screen opens) 

2.3.1. First time only – Select the Install button 
3. From Mobile Manager Pro 

3.1. Select the Options Menu button to expose its menu option 
3.2. Select the Settings option from the menu 

3.3. Enter the info displayed for these two fields and you are connected to your shop management systems database 

Local IP 
Enter the Local IP address of your database host computer displayed in the Server IP Address: of the Mobile Manager Setup 

Port  
Enter the Port number displayed in the Server Port: of the Mobile Manager Setup 

Status Automation 
Automatically change the order status when certain actions are performed 

Work Order Created 
Automatically set the Status of the work order when it is created from Mobile Manager Pro. This helps to make the newly created 
orders easier to identify in the work in progress screen of your management system 

1. Select the lookup button to the right of the Work Order Created line 
2. Select the Status from your shop management systems status list that you would like to automatically set the order status 

to when you create an estimate from Mobile Manager Pro 
3. If you do not see an appropriate status, create one in your shop management system then return to step 1 

Inspection Created 
Automatically change the Status of the work order when a Digital Multi Point Inspection (DMPI) is created. This helps to make 
orders that have a DMPI created easier to identify in the work in progress screen of your management system 

1. Select the lookup button to the right of the Inspection Created line 
2. Select the Status from your shop management systems status list that you would like to automatically set the order status 

to when you create a Multi Point Inspection for the order 
3. If you do not see an appropriate status, create one in your shop management system then return to step 1 

Work Order Completed 
Automatically change the Status of the work order when all check boxes are checked on the Order tab in Mobile Manager Pro. 
This helps to make completed orders easier to identify in the work in progress screen of your management system 

1. Select the lookup button to the right of the Work Order Completed line 
2. Select the Status from your shop management systems status list that you would like to automatically set the order status 

to when you create an estimate from Mobile Manager Pro 
3. If you do not see an appropriate status, create one in your shop management system then return to step 1 

Inspection Completed 
Automatically change the Status of the works order when a Digital Multi Point Inspection is marked completed. This helps to make 
orders that need to have their DMPI’s reviewed easier to identify in the work in progress screen of your management system 

1. Select the lookup button to the right of the Inspection Completed line 
2. Select the Status from your shop management systems status list that you would like to automatically set the order status 

to when you create an estimate from Mobile Manager Pro 
3. If you do not see an appropriate status, create one in your shop management system then return to step 1 

Printers 
This is the section where you give the tablet the ability to print lube stickers and Key Tags  from Mobile Manager Pro 
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Lube Sticker Computer Name 
1. Go to the computer that has your lube sticker printer connected to it 
2. Select the Windows Start  button 
3. Right Select Computer and Select Properties 
4. Scroll to the section “Computer name, domain, and workgroup settings 
5. Take note of the Computer Name then enter it to this field 

KeyTag Computer Name 
1. Go to the computer that has your keytag sticker printer connected to it 
2. Select the Windows Start  button 
3. Right Select Computer and Select Properties 
4. Scroll to the section “Computer name, domain, and workgroup settings 
5. Take note of the Computer Name and enter it to this field 

ProDemand / ShopKeyPro 
This is the section where you enter your credentials for ProDemand or ShopKeyPro for integration of the ProDemand/ShopKey 
Pro  features from the Order tab in Mobile Manager Pro. In addition to the data being transferred to the repair order, pictures are 
also added for fast reference right from the Order tab in Mobile Manager Pro 

Labor Estimator 

Parts Estimator 

Maintenance 

Fluids 

TSBs 

Tire Fitment 

Wiring Diagrams 
1. Select the Enter Account Credentials 
2. The Login screen opens 
3. Select the account that you have 

3.1. ProDemand 
3.2. ShopKeyPro 

4. Enter your Account ID on the first line 
5. Enter your password on the second line 
6. Select the OK button 
7. Optionally check off Automatically add recent TSBs to new work orders 

Repair 
This is the section where you check off what Repair information that you have a subscription to and would like to access from the 
vehicle tab of an order within Mobile Manager Pro. Functionality of the websites on mobile devices is not controlled by Mobile 
Manager Pro rather; it will deliver the vehicle data to the website for quick access to the right information. 

ProDemand 
Check this box if you have an active subscription and would like to access this data from Mobile Manager Pro 

ShopkeyPro 
Check this box if you have an active subscription and would like to access this data from Mobile Manager Pro 

AllData Repair 
Check this box if you have an active subscription and would like to access this data from Mobile Manager Pro 

Assign a Tablet to a User 
Setting this option is required for the Team Chat functionality and prepares the stage for additional “User Specific” activity 
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1. From Mobile Manager 
2. Select the Options menu 
3. Select the menu option User. If tablet is already assigned to a user, touch the users name that the tablet is currently 

assigned to. A pick list of users from your management system is displayed 
4. Select the user that you would like to assign the tablet to 

Access my Work In Progress 
Select this option to view the Work In Progress (WIP) items in your management system. 
1. From Mobile Manager 
2. Select the Options Menu 
3. Select the Work In Progress option from the menu 

Verify Server Configuration 
If your Work In Progress does not load within a few seconds, follow these steps to verify your Server Configuration. 
1. From you data host machine 

1.1. Launch C:\BOT\MobileConfig.exe. A window will open displaying the IP Address and Port Number that should be entered 
in Mobile Manager Pro 
1.1.1. Local IP address 
1.1.2. Port  

2. Verify that your tablet is connected to the same secure network that your workstation computers are connected to 
2.1. The first three series of numbers in your tablets IP address of should match the first three series of numbers of your data 

Server 
2.1.1. If your server is 192.168.1.15 then the tablet should have 192.168.1.{some number} 

3. Disconnect/Reconnect to your Wi-Fi 
4. Check notifications on your tablet to see if there is an Operating System update pending installation 
5. If all of the previous steps are verified to be correct, connect your management system host computer to a remote session via 

http://boltontechnology.com/support.html so we can verify the firewall and tcp/ip settings for SQL server 
5.1. SQL Server may need an incoming rule to allow UDP connections on port 1434 

Start New Estimate 
There are four methods to start a new estimate. Three of them begin from the Work In Progress screen, the other is from the 
Schedule screen 

For an Existing Customer Existing Vehicle 
1. From the Mobile Manager Work In Progress screen 
2. Select the Activity Menu 
3. Select New Estimate 
4. Select which option you would like to search by 

4.1. Search By Customer Name 
Search is by Last Name,First Name 

4.2. Search By License 
4.3. Search By VIN 

Search results are listed showing by Customer, followed by all vehicles owned by that customer.  
5. Select the vehicle for the new estimate. The selected item is indicated by an orange highlight bar on the left side 
6. Select the Start Order button at the bottom of the screen 

For an Existing Customer New Vehicle 
1. From the Mobile Manager Work In Progress screen 
2. Select the Activity Menu 
3. Select New Estimate 
4. Select which option you would like to search by 

4.1. Search By Customer Name 
Search is by Last Name,First Name 

4.2. Search By License 

http://boltontechnology.com/support.html
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4.3. Search By VIN 
Search results are listed showing by Customer, followed by all vehicles owned by that customer.  
5. Select the customer you would like to create a new vehicle for. The selected item is indicated by an orange highlight bar on the 

left side 
6. Select the Activity Menu 

6.1. Select New Vehicle from the Activity Menu 
For efficiency, you are taken immediately to the Order details screen to begin preparing the order. Don’t forget to Scan and 
Decode a VIN Code or Decode a License Plate from the Vehicle tab to ensure accurate vehicle data capture 

For a New Customer New Vehicle 
If no results are found, double check your search method before creating a new customer/vehicle to prevent creating duplicate 
records in your system 
1. From the Mobile Manager Work In Progress screen 
2. Select the Activity Menu 
3. Select New Estimate 
4. Select which option you would like to search by 

4.1. Search By Customer Name 
Search is by Last Name,First Name 

4.2. Search By License 
4.3. Search By VIN 

Search results are listed showing by Customer, followed by all vehicles owned by that customer.  
5. From your search results, select the Activity Menu 
6. Select the New Customer activity 
Don’t forget to Scan and Decode a VIN Code or Decode a License Plate from the Vehicle tab to ensure accurate vehicle data entry. 
Optionally, customer data can be entered from the Customer tab, or just wait to get to the workstation to use the big screen and 
keyboard 

By converting an appointment from the Schedule Screen 
Got a busy WIP screen, no problem. Start your Estimates from the Schedule screen of Mobile Manager Pro similar to how you do 
it from your shop management systems scheduler. 
1. From Mobile Manager Select the Options Menu 
2. Select the Schedule option from the Options Menu (A view of today’s schedule is shown) 
3. Select the day you wish to view 

3.1. select the scroll arrows located near the top of the screen where the date is displayed in the middle to scroll one day at a 
time 

3.2. select the date displayed to expose the Jump To date option 
4. This is read only and details are displayed regarding the appointment 
5. Touch the appointment to step in to the associated order 
6. If no order exists for this appointment you will be prompted to convert the appointment to an estimate and step in to a New 

Estimate for the selected customer. 
6.1. If no vehicle is available with the appointment, you will be presented with a list of vehicles under that customer. Adding a 

new vehicle from this option is not currently available. To achieve this, go to the For an Existing Customer New Vehicle 
method 

Search My WIP 
1. From the Work In Progress Screen 
2. Select the Activity Menu 
3. Select the Search activity 
4. Enter your search criteria 
5. Touch the magnifying glass to perform the search 
6. Your Work In Progress screen is filtered to the search results 

Filter and Sort the Items I see in my WIP 
1. From the Work In Progress Screen 
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2. Select the Activity Menu 
3. Select the Display activity 
4. Check the item types you would like to show 

4.1. Estimates 
4.2. Repair Orders 
4.3. Invoices 

5. In the Sort By option Select How you would like to sort the results 
5.1. Customer 
5.2. Vehicle 
5.3. Order # 
5.4. Order Type 
5.5. Status 
5.6. Promised Date 
5.7. Scheduled Date 

6. In the Filter By Technician, Select the technician that you would like to filter the results to. 
HINT: Filtering To Repair Orders, Sorting by the Promised Date and Filtering By a Technician will help the technician be more 
efficient and be aware of what is coming due 

Manually Refresh my WIP Screen 
Occasionally you may need to transition from a desktop to a mobile device quickly. Instead of waiting for the Mobile Manager WIP 
screen to auto-refresh, you can perform a manual refresh to retrieve the updates that you just performed from the desktop 
1. From the Mobile Manager Work In Progress 
2. Select the Activity Menu 
3. Select the Refresh Activity 

View order details 
1. From the Mobile Manager Work In Progress 
2. Select the Order you wish to view 

Add a Canned Job to an order 
There are 3 ways to add jobs to the order from Mobile Manager Pro 

From your Quick Menu 
This is a list of jobs that are flagged in your management system to display in your quick list 
1. From the Mobile Manager Order screen 
2. Select the Activity Menu 
3. Select the Add Canned Job (Quick) activity. A list of jobs from your management system flagged for Quick Menu is displayed 
4. Check off each of the jobs that the vehicle needs performed today 
5. Select the OK button to add the selected jobs to the order or Cancel to return to the Order 

Filtered By Canned Job Category 
1. From the Mobile Manager Order screen 
2. Select the Activity Menu 
3. Select the Add Canned Job (Category) activity. A list of Categories from your management system is displayed 
4. Select the Category from the list. A list of jobs with that category assigned in your management system is displayed 
5. Check off each of the jobs from that category that the vehicle needs performed today 
6. Select the OK button to add the selected jobs to the order or Cancel to just return to the order 

From a List of All of your Canned Jobs 
1. From the Mobile Manager Order screen 
2. Select the Activity Menu 
3. Select the Add Canned Job (All) activity. A list of all jobs from your management system is displayed 
4. Check off each of the jobs from that the vehicle needs performed today 
5. Select the OK button to add the selected jobs to the order or Cancel to just return to the order 
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Add a Labor Line 
1. From the Mobile Manager Order Screen 
2. Select the Plus symbol in the Activity bar 
3. Select the Labor activity 
4. Enter the details for the Labor line 

4.1. Charged Hours 
4.2. Category 
4.3. Symptom 
4.4. Work Requested 
4.5. Work Performed 
4.6. + Add Technician 

5. Touch the Back arrow (Top Left Corner) to return to the Order Tab 

Add a Symptom 
1. From the Mobile Manager Order screen 
2. Select the Plus symbol in the Activity bar 
3. Select the Add Symptom. A list of symptoms from your management system is displayed. If you do not see the symptom you 

need, first add it as a symptom in your management system or look it up in Pro Demand for an OEM standard symptom 
4. Select the symptom you would like to add to the order or the Cancel button to just return to the order 

Add a Note 
1. From the Mobile Manager Order screen 
2. Select the Plus symbol in the Activity bar 
3. Select the Add Note activity 
4. If you do not want this note to print on the order, uncheck the Print On Order checkbox 
5. Select the note text box to open the keyboard 
6. Type the note or if you do not like to type, select the microphone on the keyboard to have Android convert your speech to text 
7. Optionally select the camera icon to attach a picture to this note 
8. Touch the Back arrow (Top Left Corner) to return to the Order Tab 

Add a Part 
1. From the Mobile Manager Order screen 
2. Select the Plus symbol in the Activity bar 
3. Select the Add Part activity 
4. Scan or enter the part number. Please note that when scanning, you are typically scanning the SKU number which means that 

your inventory will need to have SKU numbers stored as part numbers for the part 
5. Enter the reference number for the part 
6. Enter the Quantity for the parts 
7. Enter a Description for the part 
8. Select a Category for the part 
9. Select a Vendor for the part 
10. Optionally select the camera icon to take a picture for the part 

Add Technician to Labor Line 
1. From the Mobile Manager Order screen 
2. Select the Labor Line you would like to assign to a technician 
3. In the Technicians section, Select the + Add Technician 
4. Touch in the Technician box to open the Labor Technician screen 
5. Touch in the Technician box to open the Technician screen 
6. Select the technician from the list 
7. Enter the Pay Hours 
8. Enter the Actual Hours 
9. Select the OK button 
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Change Technician on Labor Line 
1. From the Mobile Manager Order screen 
2. Select the Labor Line you would like to change the technician 
3. In the Technicians section, Select the technician you would like to change 
4. Touch in the Technician box to open the Technician screen 
5. Select the technician from the list 

5.1. Optionally edit the Pay Hours 
5.2. Optionally edit the Actual Hours 

Access ProDemand / ShopKeyPro data 

Print a Lube Sticker 
1. From the Mobile Manager Order screen 
2. Select the Print Lube Sticker activity 
3. Select the Lube Sticker interval to apply 
4. Select the Print button to print a lube sticker or Cancel to return to the order 

Print a Key Tag 
1. From the Mobile Manager Order screen 
2. Select the Activity menu 
3. Select the Print Key Tag activity 

Capture a Signature 
This feature will allow you to capture a digital signature on the tablet. When captured, it will remain with the Estimate, Order 
and Invoice and print on the Report Pro invoice as the signature. Pricing and individual event authorization is not yet available. 
Be sure to check your local laws as they pertain to digital signatures. 

1. From the Mobile Manager Order Screen 
2. Select the Activity Menu 
3. Select the Capture Signature activity 
4. Have the customer user their finger or a stylus to sign on the tablet screen 
5. Select the Save button to save the signature or the X button to erase and resign. Select the back button on your device to 

return to the order. 

View customer details 
Use this section to capture basic information about your customer 
1. From the Mobile Manager Order Screen 
2. Select or Swipe to the Customer tab 

2.1. Name, Address, Email and Phone number details are displayed and can be viewed/edited on this screen 

Send a Text Message 
1. From the Customer tab of an Order in Mobile Manager Pro 
2. Select the Activity menu 
3. Select the Send Text Message activity. A new window opens and prefills the phone number with the linked phone number label 

in Message Manager. 
4. Verify or change the phone number 
5. Type in your message 
6. Select the send arrow 

Map the customers address 
1. From the Customer tab of an Order in Mobile Manager Pro 
2. Select the Activity menu 
3. Select the Map Address activity. Google maps will open with directions to the customers address from your current location. 
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View vehicle details 
1. From the Mobile Manager Pro order screen 
2. Select or Swipe to the Vehicle Tab 

2.1. Year, Make, Model, Vin, License and State can be viewed/edited and Vehicle Recommendations can be viewed 

Add a Recommendation 
1. From the Vehicle tab of an Order in Mobile Manager Pro 
2. Select the Activity Menu 
3. Select the Add Recommendation activity 
4. Select the date that the recommendation is needed by 
5. Select the Category for the recommendation 
6. Select the Work Recommended box and enter the description for the recommendation. Don’t like typing….select the 

microphone on the keyboard and speak clearly in to the microphone. Android will convert your speech to text and enter it to 
the field 

7. Select the Activity Menu 
8. Select the Save activity 

Give the vehicle a profile picture 
1. From the Vehicle tab of an Order in Mobile Manager Pro 
2. Select the Activity Menu 
3. Select the Attach Vehicle Image activity (the camera app opens) 
4. Take a picture of the car 

4.1. Select the check to save it to the vehicle 
4.2. Select the Redo arrow to retake a new picture 
4.3. Select the X to cancel and return to the Vehicle tab 

Scan and Decode a VIN Code 
1. From the Vehicle tab of an Order in Mobile Manager Pro 
2. Select the barcode image next to the Vin field 
3. Focus tablet camera over VIN code sticker on the vehicle. HINT: Using one hand typically has less shaking. Start with the camera 

close to the barcode and slowly move away. 
4. If the VIN is not decoded quickly or is not decoded accurately via this method, do not waste time trying to force it by rescanning 

the barcode over and over. Instead, jump right to Decode a License Plate. (Note that vehicles not registered with the DMV are 
not available for license plate decode) 

Decode a License Plate 
1. From the Vehicle tab of an Order in Mobile Manager Pro 
2. Enter the License (Plate and State) 
3. Select the Activity Menu 
4. Select the Decode License 
5. VIN will auto populate if the license is found and then auto decode 
6. Select the appropriate sub-model information for the vehicle 

Access Repair Information 
1. From the Vehicle tab of an Order in Mobile Manager Pro 
2. Select the Activity Menu 
3. Select the Repair Information activity 
4. Select the appropriate repair site you wish to use 
5. You are directed to the site. First time you will need to log in 

View vehicle history 
1. From an Order in Mobile Manager Pro 
2. Select or swipe to the History tab 
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Search Vehicle history 
1. From the History tab of an Order in Mobile Manager Pro 
2. Select the Activity Menu 
3. Select the Search activity 
4. Enter the text you would like to search for 
5. Select the magnifying glass on the keyboard to execute the search 
6. The history view is then filtered to your search results 

View Multi Point Inspection history 
1. From an Order in Mobile Manager Pro 
2. Select or swipe to the Inspection tab 

2.1. To open an  inspection, select it from the list 
2.2. To delete an inspection long press and then confirm the delete  

Add a Digital Multi Point Inspection to this vehicle 
1. From an Order in Mobile Manager Pro 
2. Select or swipe to the Inspection tab 
3. Select the Activity menu 
4. Select the Add New Inspection activity. (A list of your available inspections opens) 
5. Select the Inspection that you would like to add to this order 

Share a Digital Multi Point Inspection 

Via Text Message 
1. From the DMPI screen, select the share icon on the action bar. It’s the less than symbol with three dots 
2. Select Share via Text 
3. Verify the phone number and message 
4. Select the send arrow 

Via Email 
1. From the DMPI screen, select the share icon on the action bar. It’s the less than symbol with three dots 
2. Select Share via Email 

2.1. If both Email and Gmail are configured on the tablet, select the App that you prefer to use from the prompt screen 
3. Verify the To and From email addresses and the email message 
4. Select the send arrow 

Create Templates for Sharing Inspections 
When creating templates for sharing, there are merge tags available that dynamically merge Inspection specific data with the 
message body to personalize the message for the customer. Select the blue ? to see a list of available merge tags. 

Via Text Message 
1. From Report Pro 
2. Select the Customize Tab 
3. Select the Customize M.P. Inspection button 
4. Select the Settings tab 
5. In the Share Via Text Message section, enter your preferred message body. Be sure to keep the number of characters less 

than 160 keeping in mind that the merge tags will add characters of variable lengths 
6. Sample: 

Hi [CUSTOMER], 
Here is a link [URL] to your [TITLE] report for your [VEHICLE] 

Via Email Template 
1. From Report Pro 
2. Select the Customize Tab 
3. Select the Customize M.P. Inspection button 
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4. Select the Settings tab 
5. In the Share Via Email Message section, enter your preferred message body. 
6. Sample: 

Hi [CUSTOMER], 
Here is a link [URL] to your [TITLE] report for your [VEHICLE] 
A service advisor will call you to review the report and answer any questions you may have regarding it. 

Change the Status of a Digital Multi Point Inspection 
For ease of use, statuses are automated and you can optionally have the Invoice Status automatically updated. See Status 
Automation for configuration 
When the DMPI is created the DMPI status is Waiting. When the first item is selected, the Status updates to In Progress and when 
75% or more of the line items are completed, the tech will be prompted to mark it complete when the back arrow is selected 
To manually set the status 
1. From the DMPI screen 
2. Select the Inspection Status 
3. Select the Status from the list of available statuses 

Access my management systems Schedule 
This will provide access to the schedule in your shop management system with a by the day view with today as its default day. 
Auto scheduled appointments that do not have a linked order can be converted to an estimate by selecting it. 
1. Select the Schedule option from the Options Menu (A view of today’s schedule is shown) 
2. Select the day you wish to view 

2.1. select the scroll arrows located near the top of the screen where the date is displayed in the middle to scroll one day at a 
time 

2.2. select the date displayed to expose the Jump To date option 
3. This is read only and details are displayed regarding the appointment 
4. Touch the appointment to step in to the associated order 

4.1. If no order exists for this appointment you will be prompted to convert the appointment to an estimate and step in to a 
New Estimate 

Post in Team Chat 
This requires that the tablet be assigned to a user since the message must be stamped with who is posting the message. See 
Assign a Tablet to a User 
1. From the Work In Progress screen of Mobile Manager Pro 
2. Select the Options Menu or Swipe from left to right starting off screen 
3. Select the Team Chat 
4. Type in your message 
5. Select the send arrow 

View Release Highlights 
Selecting this action will display a summary of features and fixes for each release 
1. From the Settings screen in Mobile Manager Pro 
2. Select the Activity Menu 
3. Select the Release Highlights activity 
4. Select the Close button at the bottom of the Release Highlights screen to return to the Settings screen 

MV 431 Pro 

Step By Step 
1. Create a new Order for your customer in your management system 
2. Select the Propack button 
3. Select the MV-431 button from the menu 
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4. Notice that the MV-431 screen pulls the correct information from your management system’s work order screen. If this is the 

second inspection for the vehicle you are entering in MV-431 Pro, the last insurance information and mileage are also pre-
filled 

5. Select the Sticker Number from the sticker number list that you are issuing to this vehicle 
6. Complete the rest of the MV-431 required fields 
7. Print out optional Tech Work-Sheet that can be signed by your technician 
8. Select the finish button to write your information to the MV-431 report. If selected and available for your shop management 

system, the required data is also updated on the order for that vehicle 

Void an Inspection Sticker 
If you have damaged a sticker, typically by not applying the insert correctly then follow these steps 
9. Enter the software through any means 
10. Select on the MV-431 Book Tab 
11. Highlight (Select once) the sticker in the book tab that you would like to VOID 
12. Select the VOID button at the bottom left of the page 
13. Follow the prompts to void the sticker 

Replace a sticker? 
REPLACEMENT STICKERS WORK SIMILAR TO REGULAR STICKERS, REMEMBER THIS IS USED IF YOU DID REPLACE THE CUSTOMERS 
WINDSHIELD, NOT IF YOU MESSED UP THE STICKER THAT YOU WERE AFFIXING, WHICH IS A VOID. See Void an Inspection Sticker 
14. Enter the software through your invoice for a replacement 
15. Enter in your data as normal 
16. Fill out the top two boxes on the left (THE CUSTOMER, INSURANCE, DOLLARS, STICKER, MILEAGES AND TECHNICIAN) 
17. Make sure you select that you verified your customers registration card, on the top right 
18. Select Replacement button at the top center of the form 
19. The software will prompt you for the sticker number that you are replacing. 
20. Enter that sticker number in 

Oops, I assigned the wrong sticker to this vehicle 
21. Enter the software through any means 
22. Select on the MV-431 Book Tab 
23. Highlight (Select once) the sticker in the book tab that you would to Edit 
24. Select the Sticker Management menu @ the top 
25. Select on the Sticker Mgmt Option 
26. Select on the Edit Sticker Menu 
27. Follow the prompts to complete the data change to another sticker routine 

My Stickers are not auto issuing the next sticker in order 
28. Enter the software through any means 
29. Select on the MV-431 Book Tab 
30. Highlight (Select once) the sticker in the book tab that you would to be your next sticker 
31. Select the Sticker Management menu at the top 
32. Select on the Sticker Mgmt Option 
33. Select Set as next sticker 

Enter in a new batch of stickers 
34. Select the Sticker Management menu at the top 
35. Select on the Sticker Mgmt Option 
36. Select on Book/Sticker Management 

Entering in new batch 
37. Enter the starting sticker number (REMEMBER THE FIRST TWO CHARACTERS ARE ALPHA CHARACTERS) 
38. Select the tab key (MOST OF THE LAST NUMBER WILL AUTO FILL FOR YOU) 
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39. Enter in your batch counter number (MOST SHOPS RESTART AT ONE ON EVERY NEW BATCH, IF YOU CONTINUE YOUR COUNT 

ALL YEAR JUST ENTER IN THAT NEXT POSITION NUMBER) 
40. Enter in the year you are going to use this batch 
41. On the right choose what type of sticker 
42. Select the submit button 

Why does my inspection record change location on my Mitchell1 Invoice 
THIS IS A LEGACY SETTING THAT IN THE NEW VERSION CAN BE CHANGED. THE SYSTEM WILL ALLOW YOU TO EITHER FORCE YOUR 
INSPECTION LINE TO THE TOP OF YOUR INVOICE, OR YOU CAN LEAVE THE LINE WHERE IT WAS WITHIN YOUR INVOICE. 
43. Enter the software through any means 
44. Select on File menu, and then Options 
45. On the Global Settings Screen, Select on the Global Settings tab 
46. On the right side of the options uncheck the check box “Force Inspection to Top Position” 
47. Select Save 
48. Restart the software 

My Inspection Counter (Left side of the book) is wrong, I should be on 101 instead of counter 1 
49. Enter the software through any means 
50. Select on the MV431 Book Tab 
51. Choose the page that you need to renumber 
52. Under 431 Management, Select on renumber Insp Counter 
53. Enter the number you would like to start with 
54. Select OK 

My information did not transfer to my invoice 
THE INSPECTION SOFTWARE USES KEY WORDS TO LINK THE TWO APPLICATIONS TOGETHER.  FOR THE SAFETY INSPECTION THE 
KEY WORDS ARE FOUND ON THE OPTIONS SCREEN. THE EMISSIONS TEXT PHRASE IS LOCATED ON THE BOOK TAB. 

I understand what I did, I just want to put the data on my invoice 
55. From the Main Screen, Select on the Settings Menu 
56. Select on Create Line Item 
57. Select on Show Popup Form 
58. Highlight complete text 
59. Right Select and choose copy 
60. Close all the screens for the MV 431 Software 
61. Open your invoice line, Right Select and choose Paste. 

I don’t understand why it did not go on my invoice 
IF THE TEXT ON YOUR INVOICE IS NOT IDENTICAL TO THAT OF WHICH IS STORED IN THE MV 431 SOFTWARE, THE SYSTEM DOES 
NOT KNOW WHERE TO PLACE THE COLLECTED DATA. DOUBLE CHECK YOUR VALUES UNDER THE OPTIONS AND BOOK TAB FOR 
THE SAFETY AND EMISSIONS KEY WORDS. YOU DO NOT NEED TO HAVE THE COMPLETE PHRASE, BUT RATHER THE STARTING 
POINT. THIS WILL ALLOW YOU TO HAVE MULTIPLE CANNED JOBS FOR INSPECTION 
 EXAMPLE:  PA STATE INSPECTION TEST 
 EXAMPLE: PA STATE INSPECTION – EXEMPT 
 EXAMPLE: PA STATE INSPECTION – SEMI ANNUAL 
 EXAMPLE: PA MOTOR CYCLE INSPECTION 
IN THESE EXAMPLES, CHANGE YOUR CYCLE INSPECTION TO READ (PA STATE INSPECTION – MOTOR CYCLE). THEN IN YOUR KEY 
WORDS JUST USE “PA STATE INSPECT” ALL OF THE ABOVE WILL LINK FINE. 

I want to send my data to e-Safety 
You must set up an account with Parsons before you can submit this data 
62. From the main screen Select, File then Options 
63. On the Options Screen, check off “Auto load e-Safety on Finish” 
64. Select Save 
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NOW WHEN YOU SELECT THE FINISH BUTTON, THE VERIFY REGISTRATION SCREEN (SCAN) WILL APPEAR, ON THE BOTTOM IS OUR 
e-Safety BUTTON. 

Log into your e-Safety account, using your user name and password 
65. Hover your mouse over the “New Inspection” button 
66. Hover over MV-431/ MV-480 Option and then Select on the correct vehicle type 
67. When the page re-loads Select on the File menu and then the Transfer option. 
YOUR DATA WILL NOW BE IN THE PENNDOT WEBSITE, ADD YOUR INSPECTION NUMBER AND SELECT FINAL AT THE BOTTOM OF 
THE WEB PAGE. 

I don’t like having to add only the line items associated with inspection 
 WE HAVE SIMPLFIED THIS PROCESS FOR YOU. ON THE MAIN SCREEN SIMPLY SELECT ON THE DOLLAR BUTTON, CHECK OFF 
THE LINE ITEMS THAT APPLY AND SELECT APPLY 
68. Select the Dollar ($) button on the main screen 
69. Check Include for the line items that apply 
70. Select their appropriate State Category 
71. Select the apply button 

I forget to go and make a recommendations for the customer to replace worn brakes, or tires soon 
WE HAVE SIMPLIED THIS PROCESS FOR YOU 
72. Select the “RECS” button on the main screen 
73. Check off the line items that apply 
74. Select the apply button 
 

How can I edit or add items to my recommendations 
OUR DATABASE CAN STORE UPTO 25 CANNED RECOMMENDATIONS THAT WILL ALLOW YOU EASY POINT AND SELECT INSERTION 
TO YOUR MITCHELL1/SHOPKEY SYSTEM. 
75. Select on 431 Management menu option 
76. Select on Edit Recommendations 

How do I reprint a MV431 Page  
77. Enter the software through any means 
78. Select on the MV431 Book Tab 
79. Choose the page that you need to reprint 
80. Select the Quick Print button 

Welcome Station 

Apply the basic settings 
1. From your data host workstation 
2. Open MobileConfig.exe 

This will display the settings code to be scanned later 
3. Download or locate your shop logo to the data host computer 

Recommended size for the logo is 750 x 250 in pixels 
4. Using the power cord for your tablet, connect it to the tablet and to a USB port on you data host computer. You can then 

browse the tablets directories in Windows Explorer from your data host computer. 
5. Copy your shop logo to the Downloads folder of your tablet 
6. From Welcome Station home screen 
7. Select the Tap Screen To Continue button 
8. Long Press the Have you been here before? Label 
9. Enter your PIN and select OK 
10. Select the Scan Code button 
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11. Scan the code displayed in MobileConfig.exe on your data host workstation 

This will populate the IP address and Port number needed to connect to your shop management systems database 
12. Touch the Select button 
13. Select your shop logo from the list of logos 
14. Note your Admin PIN number 

We recommend changing it to a PIN that you can easily remember 
15. Select the Save button 

Select Popular Jobs 
1. From Report Pro 
2. Select the Customize tab 
3. Select the Welcome Station button 

The Customize Welcome Stations screen opens 
4. Select the Popular Jobs option in the left panel menu 

The right panel will display a list of your canned jobs from your management system 
5. In the right panel of canned jobs, check each of the canned jobs that you would like to appear in the list of items for your 

customer to select from. 
Note that these items are currently added as notes to the Estimate in your management system in which the Service Advisor 
can then build the complete jobs from. 

6. When finished selecting the Popular Jobs, select the close button 

Seasonal Upsells 

Add new 
1. From Report Pro 
2. Select the Customize tab 
3. Select the Welcome Station button 

The Customize Welcome Stations screen opens 
4. Select the Seasonal Upsells option in the left panel menu 

The right panel will display a list of your canned Seasonal Upsell notes grouped in tabs by the seasons available 
5. In the right panel of seasonal upsell notes, select the season that you would like to add upsells to 
6. Select the Add button 
7. Enter your title and description 
8. Select the Save button to save or Cancel button to cancel your new entry 

Note that these items are currently added as notes to the Estimate in your management system in which the Service Advisor 
can then build the complete jobs from. 

9. When finished adding your seasonal upsells, select the close button 

Edit existing 
1. From Report Pro 
2. Select the Customize tab 
3. Select the Welcome Station button 

The Customize Welcome Stations screen opens 
4. Select the Seasonal Upsells option in the left panel menu 

The right panel will display a list of your canned Seasonal Upsell notes grouped in tabs by the seasons available 
5. In the right panel of seasonal upsell notes, select the season that you would like to edit 
6. Double-click the canned seasonal upsell note you would like to edit 
7. Edit your title and/or description 
8. Select the Save button to save or Cancel button to cancel your edit 

Note that these items are currently added as notes to the Estimate in your management system in which the Service Advisor 
can then build the complete jobs from. 

9. When finished editing your seasonal upsells, select the close button 
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Weather Upsells 

Add new 
1. From Report Pro 
2. Select the Customize tab 
3. Select the Welcome Station button 

The Customize Welcome Stations screen opens 
4. Select the Weather Upsells option in the left panel menu 

The right panel will display a list of your canned Weather Upsell notes grouped in tabs by the weather conditions available 
5. In the right panel of weather upsell notes, select the weather condition that you would like to add upsells to 
6. Select the Add button 
7. Enter your title and description 
8. Select the Save button to save or Cancel button to cancel your new entry 

Note that these items are currently added as notes to the Estimate in your management system in which the Service Advisor 
can then build the complete jobs from. 

9. When finished adding your weather upsells, select the close button 

Edit existing 
1. From Report Pro 
2. Select the Customize tab 
3. Select the Welcome Station button 

The Customize Welcome Stations screen opens 
4. Select the Weather Upsells option in the left panel menu 

The right panel will display a list of your canned Weather Upsell notes grouped in tabs by the seasons available 
5. In the right panel of weather upsell notes, select the weather condition that you would like to edit upsells in 
6. Double-click the canned weather upsell note you would like to edit 
7. Edit your title and/or description 
8. Select the Save button to save or Cancel button to cancel your edit 

Note that these items are currently added as notes to the Estimate in your management system in which the Service Advisor 
can then build the complete jobs from. 

9. When finished editing your weather upsells, select the close button 
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